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Welcome

The Tektronix C-PHY Tx 2.0 Automated Test software runs on Tektronix real-time oscilloscopes that are based on Windows 10 computer
operating systems. C-PHY Tx 2.0 delivers the TekExpress based C-PHY automation solution with Tx measurement.

Welcome
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C-PHY Tx 2.0 key features
C-PHY Tx 2.0 delivers 100% Automated TekExpress based C-PHY solution for all the Tx measurements.

The TekExpress C-PHY application supports the following key features:

• Supports C-PHY specification version for MIPI C-PHY 1.0, 1.1, and 2.0
• Live and pre-acquired waveform Analysis
• Easily select and configure the desired tests
• Modify limits of test parameters for debug, margin, and characterization testing
• Supports LP-TX and HS-TX signaling tests at highest symbol rate — 8 GS/s
• Supports dynamic data rate updation for the waveform captured
• Options to select LVLP, LVHS, and ALP mode functionality for LP and HS tests
• Supports Eye Diagram Test with CTLE for symbol rates above 3.5 GS/s and without CTLE at symbol rates below 3.5 GS/s
• Supports Hexagonal shaped eye diagram for devices with maximum operating symbol rates <1 GS/s and for devices with maximum

operating symbol rates ≥1 GS/s, a diamond shaped eye diagram is displayed
• Supports horizontal mask movement to a position where there are zero mask hits
• User-defined options to select three reference templates (Short, Standard, and Long) for differential insertion loss that are applicable

for all symbol rates
• Provision to run in user-defined mode with user-defined parameters for triggering the LP-HS signals
• Manual Cursor Mode support to enable the user to capture and measure the desired LP-HS regions
• Debug Mode support to load waveforms on Ref and Math channels for Analysis
• Reporting measurement test run details and repeatability with option to save the waveforms only for a fail test run.

Welcome
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Getting help and support

Product documents

Use the product documents for more information on the application functions, understand the theory of operation, how to remotely program
or operate the application, and do other tasks.

Table 1: TekExpress Application documents

To learn about Use this document
How to use the application

How to remotely control the instrument
TekExpress <Application Name> Help

PDF version of this document can be downloaded from www.tek.com/downloads

Compiled HTML (CHM) version is integrated with the application. Press F1 key from the
keyboard to start the help.

Tektronix Part Number: 077-xxxx-xx

Conventions
This application help uses the following conventions:

• The term "Application," and "Software" refers to the TekExpress Application.
• The term “DUT” is an abbreviation for Device Under Test.
• The term “select” is a generic term that applies to the two methods of choosing a screen item (button control, list item): using a mouse

or using the touch screen.
• A Note identifies important information.

Table 2: Icons used in the help

Icon Description
This icon identifies important information

This icon identifies conditions or practices that could result in loss of data.

This icon identifies additional information that will help you use the application more
efficiently.

Getting help and support
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Technical support
Tektronix values your feedback on our products. To help us serve you better, please send us your suggestions, ideas, or comments on
your application or oscilloscope. Contact Tektronix through mail, telephone, or the Web site. See Contacting Tektronix at the front of this
document for contact information.

When you contact Tektronix Technical Support, please include the following information (be as specific as possible): 

General information
• All instrument model numbers
• Hardware options, if any
• Modules used
• Your name, company, mailing address, phone number, FAX number
• Please indicate if you would like to be contacted by Tektronix about your suggestion or comments.

Application specific information
• Software version number
• Description of the problem such that technical support can duplicate the problem
• If possible, save the setup files for all the instruments used and the application
• If possible, save the TekExpress setup files, log.xml, *.TekX (session files and folders), and status messages text file

Getting help and support
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Getting started
Hardware requirements

Supported oscilloscopes
The C-PHY Tx application runs on the following Tektronix oscilloscopes:

• MSO/DPO 72304DX
• MSO/DPO 72504DX
• MSO/DPO 73304DX
• DPO71304SX/DPO71604SX/DPO72304SX/DPO73304SX
• DPO75902SX/DPO75002SX/DPO77002SX/DPO73304SX stacked setup

Minimum system requirements
The following table shows the minimum system requirements for an oscilloscope to run TekExpress.

Table 3: System requirements

Component Requirement
Processor Same as the oscilloscope
Operating System Same as the oscilloscope:

Win 10 64-bit

Memory Same as the oscilloscope
Hard Disk Same as the oscilloscope
Display Same as the oscilloscope 1

Firmware DPO/DSA/MSO TekScope v10.11.0.x or above and DPOJET v10.2.0.x or above

Software • IronPython 2.7.3 installed
• MATLAB Compiler run time v8.0
• PyVisa 1.0.0.25 installed
• Microsoft .NET 4.0 Framework
• Microsoft Internet Explorer 7.0 SP1 or greater, or other Web browser for viewing

reports
• Adobe Reader software 7.0 or greater for viewing portable document format (PDF) files

Other Devices • Matched pair of SMA cables, two-set minimum for single lane

• Microsoft compatible mouse or compatible pointing device

Note: If TekExpress is installed on a Tektronix oscilloscope, TekExpress uses a virtual GPIB port to communicate with
oscilloscope applications. If external GPIB communication devices such as USB-GPIB-HS or equivalent are used for instrument
connectivity, make sure that the Talker Listener utility is enabled in the DPO/DSA/MSO oscilloscope GPIB menu. For ease of use,
connect to an external (secondary) monitor.

1 If TekExpress is running on an instrument having a video resolution lower than 800x600 (for example, sampling oscilloscope), it is recommended that you connect a
secondary monitor. The secondary monitor must be configured and active before starting the application.

Getting started
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See also
Supported oscilloscopes and probes

Instrument connection setup

Instruments and accessories
The table below lists the instruments and accessories for C-PHY application:

Table 4: Instruments and accessories

Component Description
Oscilloscope Supported oscilloscopes and probes
Probes P77xx (P7708/13/16/20) Series Tri-mode probe with P77STFLXA

solder-in tip with TekFlex connector technology (Quantity: 3
number).

Software requirements

Downloading and installing the software
Complete the following steps to download and install the latest TekExpress <Application Name> application.

1. Go to www.tek.com.
2. Click Downloads. In the Downloads menu, select DOWNLOAD TYPE as Software and enter the application name in the MODEL OR

KEYWORD field and click SEARCH.

3. Select the latest version of software and follow the instructions to download the software. Copy the executable file into the
oscilloscope.

4. Double-click the executable and follow the on-screen instructions.

The software is installed at C:\Program Files\Tektronix\TekExpress\TekExpress <Application
Name>.

5. Select Analyze > TekExpress <Application Name> from the Oscilloscope menu, to open the application.

Activate the license
Activate the license using the Option Installation wizard in the TekScope application:

1. In the TekScope application menu bar, click Utilities > Option Installation. The TekScope Option Installation wizard opens.
2. Push the F1 key on the oscilloscope keyboard to open the Option Installation help topic.
3. Follow the directions in the help topic to activate the license.

View software version and license key details
To view version information of the application, click Options > About TekExpress.

Getting started
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Setting up the test environment

Installing the software

About setting up tests
Set up tests using the tabs in the Setup panel. Settings in the DUT tab use a top-down, left-to-right logic flow, so that any parameter that
affects or acts as a filter for other parameters appears either to the top of or to the left of the affected parameters.

Tests are saved when you save a test setup. To avoid overwriting test results, remember to assign a unique name to the test either before
running it or immediately after.

All listed tests are required for compliance testing. 

See also
Test setup overview

Before you click Start

About running tests

Instrument connection setup
The following diagram shows how to connect the DUT to the oscilloscope for all the C-PHY Tx measurements.

Click Setup > Test Selection > Schematic to view the equipment setup diagram(s).

Note: For Terminator, these probes can be connected through TCA-SMA or P77XX.

Setting up the test environment
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Figure 1: LP Transmitter

Setting up the test environment
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Figure 2: LP Transmitter - Dual Stack Connection Setup

Setting up the test environment
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Figure 3: LP-HS RTB
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TekExpress® C-PHY Automated Test Software Application Help (70K Series MSO/DPO) 19



Figure 4: LP-HS RTB - Dual Stack Connection Setup

Setting up the test environment
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Figure 5: HS Transmitter Direct Connection
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Figure 6: HS Transmitter Direct Connection - Dual Stack Setup
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Figure 7: HS Transmitter with RTB
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Figure 8: HS Transmitter with RTB - Dual Stack Connection Setup

Setting up the test environment
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Figure 9: LP Bus Turnaround
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Figure 10: LP Bus Turnaround - Dual Stack Connection Setup

See also
Minimum system requirements

Search instruments connected to the application

About setting up tests

Search instruments connected to the application
Use the TekExpress Instrument Control Settings dialog box to search the instruments (resources) connected to the application. The
application uses TekVISA to discover the connected instruments.

Note: The instruments required for the test setup must be connected and detected by the application, before running the test.

To refresh the list of connected instruments:

1. Select Options > Instrument Control Settings.

Setting up the test environment
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2. In the Search Criteria section of the Instrument Control Settings dialog box, select the connection types of the instruments to
search. Instrument search is based on the VISA layer, but different connections determine the resource type, such as LAN, GPIB, and
USB. For example, if you choose LAN, the search will include all the instruments supported by the TekExpress that are communicating
over the LAN.

3. Click Refresh. The TekExpress application searches for the connected instruments.

Figure 11: Search status of the instruments connected to LAN

4. When the search is complete, a dialog box lists the instrument-related details based on the search criteria. For example, for the Search
Criteria as LAN and GPIB, the application displays all the LAN and GPIB instruments connected to the application.

Figure 12: TekExpress Instrument Control Settings window

The details of the instruments are displayed in the Retrieved Instruments table. The time and date of instrument refresh is displayed in
the Last Updated field.

Test setup overview
A test setup includes configuration parameters and report options. Use the options in the Setup panel and Reports panel to select and
configure tests. 

1. Select the DUT parameters.
2. Select one or more tests.
3. Configure test parameters.
4. Select test notification preferences.
5. Select report options.

See also
Pre-test checklist

Before you click Start

Setting up the test environment

TekExpress® C-PHY Automated Test Software Application Help (70K Series MSO/DPO) 27



About running tests

About running tests
After selecting and configuring the test, review the pre-run checklist and then click Start to run the tests. While tests are running, you
cannot access the Setup or Reports panels. To monitor the test progress, switch back and forth between the Status panel and the Results
panel.

The application displays a report when the tests are complete. While the tests are running, other applications may display windows in the
background. The TekScope application takes precedence over other applications, but you can switch to other applications by using the Alt
+ Tab key combination. To keep the TekExpress C-PHY Tx application on top, select Keep On Top from the C-PHY Tx Options menu. 

See also
Configure test parameters

About setting up tests

Before you click Start

Before you click start
Before you run tests for the first time, do the following: 

1. Understand where your test files are stored on the instrument.
2. Map my TekExpress folder as X: (X drive) on all instruments used in test setup running Microsoft Windows Operating System.

The My TekExpress folder has the shared name format <domain><user ID>My TekExpress. Or, if the instrument
is not connected to a domain, then the shared name format is <instrument name><user ID>My TekExpress. This
shared folder is used to save the test session files and is used during any other file transfer operations.

Note: If the X: drive is mapped to any other shared folder, the application will display a warning message asking you to
disconnect the X: drive manually.

3. Make sure that the My TekExpress folder has read and write access and that the contents are not set to be encrypted:

a. Right-click the My TekExpress folder and select Properties.
b. Select the General tab and then click Advanced.
c. In the Advanced Attributes dialog box, make sure that the option Encrypt contents to secure data is NOT selected.

4. Review the pre-run checklist before you run a test.

See also
View test-related files

Application directories and file types

File name extensions

Pre-test checklist
Do the following before you click Start to run a test. If this is the first time you are running a test for a setup, refer to the information in
Before you click Start.

On the oscilloscope:

• Make sure that all the required instruments are properly warmed up (approximately 20 minutes).
• Perform Signal Path Compensation (SPC).
• Perform deskew on any cables.

Setting up the test environment
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In the C-PHY Tx application:

• Verify that the application is able to find the instrument. If it cannot, perform a search for connected instruments.

See also
Instrument connection setup

Setting up the test environment
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Starting the application
To start the TekExpress C-PHY, select Analyze > TekExpress C-PHY from the oscilloscope menu bar.

During start, a "My TekExpress" folder is created in the Documents folder of the current user and gets mapped to "X" drive. When the
application is closed properly, the "X" drive gets unmapped. Session files are then stored inside the X:\C-PHY folder. If this file is not
found, the application runs an instrument discovery program to detect connected instruments before starting TekExpress C-PHY.

To keep the TekExpress C-PHY application on top of any application, select Keep On Top from the options menu. If the application goes
behind the oscilloscope application, select Analyze > TekExpress C-PHY to bring the application to the front.

Application controls
This section describes the application controls.

Table 5: Application control description

Item Description
Options menu Menu to display global application controls.

Table continued…

Starting the application
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Item Description
Test panel Controls that open tabs for configuring test settings and options.

Start / Stop button Use the Start button to start the test run of the measurements in the selected order. If prior
acquired measurements are not cleared, then new measurements are added to the existing
set.

The button toggles to the Stop mode while tests are running. Use the Stop button to abort
the test.

Pause / Continue button Use the Pause button to pause the acquisition. When a test is paused, this button changes
as Continue.

Clear button Use the Clear button to clear all existing measurement results. Adding or deleting a
measurement, or changing a configuration parameter of an existing measurement, also
clears measurements. This is to prevent the accumulation of measurement statistics or
sets of statistics that are not coherent. This button is available only on Results panel: View
summary of test results on page 50.

Note: This button is visible only when there are results data on the panel.

Application window move icon Place the cursor over the top of the application window to move the application window to
the desired location

Minimize icon Minimizes the application.

Close icon Close the application.

Mini view / Normal view Toggles the application between mini view and normal view.

Mini view displays the run messages with the time stamp, progress bar,

Start / Stop button, and Pause / Continue button.

The application moves to mini view when you click the Start button.

Starting the application
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Options menu functions
To access the Options menu, click  in the upper-right corner of the application. It has the following selections:

Options menu

Figure 13: Option menu

Table 6: Options menu settings

Menu Function
Default Test Setup Opens a new test setup with default configurations.
Open Test Setup Opens a previously saved test setup. Displays the list of previously saved test setup file

names. Make the selection and click OK to open the test setup.
Save Test Setup Saves the current test configurations with the specified file name.
Save Test Setup As Saves the current test setup with a different file name or file type.
Open Recent Displays the recently opened test setup file names. Make the selection and click OK to

open the test setup.
Instrument Control Settings Detects, lists, and refreshes the connected instruments found on the specified connections

(LAN, GPIB, USB, Serial, Non-VISA Resources, TekLink, and VXI).

Keep On Top Always keeps the TekExpress application on top of all the applications.

Email Settings Configures email options for test run and result notifications.
Help Displays the TekExpress help.
About TekExpress Displays the application name, version, and hyperlink to end the user license agreement.

Starting the application
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Configure email settings
Use the Email Settings utility to get notified by email when a measurement completes or produces any error condition. Follow the steps to
configure email settings: 

Figure 14: Email settings window

1. Select Options > Email Settings to open the Email Settings dialog box.
2. (Required) For Recipient email Address(es), enter one or more recipient email addresses. To include multiple addresses, separate

the addresses with commas.
3. (Required) For Sender’s Address, enter the email address used by the instrument. This address consists of the instrument name,

followed by an underscore, followed by the instrument serial number, then the @ symbol, and the email server ID. For example:
user@yourcompany.com.

4. (Required) In the Server Configuration section, type the SMTP Server address of the Mail server configured at the client location,
and the SMTP Port number, in the corresponding fields.

If this server requires password authentication, enter a valid login name, password, and host name in the corresponding fields.

Note: If any of the above required fields are left blank, the settings will not be saved, and email notifications will not be sent.

5. In the Email Attachments section, select from the following options:

• Reports: Select to receive the test report with the notification email.

• Status Log: Select to receive the test status log with the notification email. If you select this option, then also select whether you
want to receive the full log or just the last 20 lines.

6. In the Email Configuration section:

• Enter a maximum file size for the email message. Messages with attachments larger than this limit will not be sent. The default is
0 MB.

• Enter the number in the Number of Attempts to Send field, to limit the number of attempts that the system makes to send a
notification. The default is 1. You can also specify a timeout period.

7. Select the Email Test Results When complete or on error check box. Use this check box to quickly enable or disable email
notifications.

8. To test your email settings, click Test Email.
9. To apply your settings, click Apply.
10. Click Close when finished.

Starting the application
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TekExpress instrument control settings
Use the TekExpress Instrument Control Settings dialog box to search the instruments (resources) connected to the application. You
can use the Search Criteria options to search the connected instruments depending on the connection type. The details of the connected
instrument is displayed in the Retrieved Instruments window.

To access, click Options > Instrument Control Settings. Select USB and LAN as search criteria for TekExpress application and click
Refresh. The connected instruments displayed in the Retrieved Instruments window and can be selected for use under Global Settings in
the test configuration section. 
Figure 15: TekExpress Instrument Control Settings window

See also
Options menu functions on page 32

Starting the application
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Setup panel: Configure the test setup
The Setup panel contains sequentially ordered tabs that help to guide you through a typical test setup process.

Items selected in one Setup tab may change options available in the other tabs. You can switch between the tabs in any order to modify
your test parameters.

Also refer
DUT: Set DUT settings on page 36

Test Selection: Select the tests on page 39

Acquisitions: Set waveform acquisition settings on page 40

Configuration: Set measurement limits for tests on page 42

Preferences: Set the test run preferences on page 45

Setup panel: Configure the test setup
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DUT: Set DUT settings
Use the Setup panel DUT tab to select parameters for the device under test. The settings are global and apply to all tests for the current
session. The DUT settings available and the options in the drop-down list depends on the selections made in the settings. DUT settings
also affect the list of available tests in the Test Selection tab.

Figure 16: DUT tab settings

Click Setup> DUT to access the DUT parameters.

Table 7: DUT tab parameter settings

Parameter Description
DUT ID Adds an optional text label for the DUT to reports. The default value is

DUT001. The maximum number of characters is 32.

You cannot use the following characters in an ID name:

(.,..,...,\,/:?”<>|*).

 Comments icon (to the right of the DUT ID field)
Open a Comments dialog box which allows you to enter optional text to
add to a report. You can enter a maximum number of 256 characters. Refer
Configure report view settings to enable or disable comments which appear
on the test report.

Table continued…

Setup panel: Configure the test setup
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Parameter Description
User Defined Acquisition Select the check box to enable Ref or Math channel in the Acquisitions tab

and run the test.

Prerequisite:

• Ensure waveform is available/recalled on selected source each time
before click on "Start".

• Waveform is saved for the selected source in TekExpress session and
the scope settings are overridden during test run in UDA Mode.

Acquire live waveforms Acquire active signals from the DUT for measurement and analysis.
Use prerecorded waveform files Run tests on a saved waveform. Refer Load a saved test

setup on page 55 to save the test setup.
Session Allows you to save multiple config sessions and run multiple config/run

sessions together.
Device Select Device name as Transmitter.
Version Displays the CTS version. C-PHY application supports CTS 2.0, 1.1, and

1.0 version.

Select the Version from the drop-down:

• C-PHY 2.0 for CTS 1.0 Spec 2.0
• C-PHY 1.1 for CTS 1.0 Spec 1.1
• C-PHY 1.0 for CTS 1.0 Spec 1.0

Device Profile
Symbol Rate Select one or multiple data rates for waveform acquisition.
Calculate Computes Symbol Rate of HS signals.

Note: There will be mis-match in the auto-calculated dynamic data
rate value if the LP region is dominant in the captured signal from
the DUT.

Auto calculation of Symbol Rate is applicable only for HS Signal
Types.

Signal Type Select the Signal type from the drop-down:

• HS
• LP
• LP-HS

Note: Based on the selection of Signal Type, the list of tests will
change in the Test Selection panel.

LVLP Available only when Version=C-PHY 2.0

Select the check box to run the low voltage low power tests.

LVHS Available only when Version=C-PHY 2.0

Select the check box to run the low voltage high speed tests.

Table continued…
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Parameter Description
ALP Mode Select the check box to run the Alternate Low Power

Note: It is applicable for Test ID 1.2.19 only

Termination Voltage Enter the Termination Voltage value for the direct connection from DUT to
oscilloscope.

Note: Equals 0 for RTB and VCPTX for direct connection.

T3 Post Duration (UI) Enter T3 Post Duration in terms of number of unit interval.

Note: Enter number of 4's, which should be adjustable at the
transmitter from 7 UI minimum to 224 UI maximum in increments
of 7 UI.

T3-PROGSEQ Select if DUT supports T3-PROGSEQ for Test ID 1.2.3, 1.2.4, 1.2.5, 1.2.6
PROGSEQ When selected, the DUT supports the programmable sequence.
Sequence Enter the programmable sequence value.

See also
About setting up tests

Setup panel: Configure the test setup
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Multiple-session run
Multiple-sessions run feature allows you to save multiple config sessions and runs the multiple config/run sessions together.

Click ( ) button in the DUT panel. The Run/Config Sessions window displays the list of saved Run/Config sessions.

Run the test that are selected in the Test Selection tab, the Run sessions are created automatically and displayed in the Run/Config
Sessions window after the test is executed. You can also save the Config session by configuring the settings in the application.

The Run/Config sessions window provides the summary of the sessions with session name, Type. You can also note-down the
configuration changes in the comment column.

The Run/Config Session window allows you to save, load, delete, and set the sessions as default.

• Session Name: Enter the name to save the config session. The maximum number of character supported is 40 and special characters
(.,..,...,\,/:?”<>|*) are not supported.

• Save: Save current configuration as a session with the given session name.
• Close: Close the Run/Config Session window.
• Default: Sets the application configurations to default values.
• Load: Load the selected config/run session.
• Delete: Delete the selected config/run session.
• Run Sessions: Run the selected config/run session.

Enable/ Disable the Multi Run session
By default the Multi Run Session is enabled in the application. Set the IsMultiSessionRunEnabled value to false to disable the Multi Run
Session feature in the TekExpress.exe.Config file, which is downloaded along the application.

Test Selection: Select the tests
Use the Test Selection tab to select C-PHY tests. Listed tests depend on settings in the DUT tab.

Setup panel: Configure the test setup
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Table 8: Test Selection tab settings

Setting Description

Deselect All, Select All, Deselect or selects all tests in the list.
Select Required Selects the required test in the listed tests.

Tests Click a test to select or deselect. Selecting a test also show details about the selected test
in the Test Description panel.

All required tests are selected in the Compliance test mode.

Show MOI Displays MOI document when you click the button.

Schematic Displays equipment connection setup for the selected measurements. You need to select
at least a measurement before you click the Schematic button.

See also
About setting up tests

Acquisitions: Set waveform acquisition settings
Use Acquisitions tab to view the test acquisition parameters. The contents displayed on this tab depends on the DUT type and the tests
selected.

Setup panel: Configure the test setup
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Table 9: Acquisition tab settings

Settings Description
Lane Select the lane from the drop-down:

• Lane0
• Lane1
• Lane2
• Lane3

View Probes Displays the list of connected probes.

Table continued…

Setup panel: Configure the test setup
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Settings Description
VA, VB, VC Selects the lane from the drop-down and are based on the selection of User Defined

Acquisition in the DUT panel:

• CH1
• CH2
• CH3
• CH4
• REF1
• REF2
• REF3
• REF4
• MATH1
• MATH2
• MATH3
• MATH4

Acquisition and Save Options All waveforms are saved before analysis
Show Acquire Parameters When enabled displays the parameter name.

TekExpress C-PHY saves all acquisition waveforms to files by default. Waveforms are saved in a unique folder for
each session (a session is started when you click the Start button). The folder path is X:\C-PHY\Untitled
Session\<dutid>\<date>_<time>. Images created for each analysis, XML files with result values, reports, and other
information specific to that particular execution are also saved in this folder. Saving a session moves the session file contents from the
Untitled Session folder to the specified folder name and changes the session name to the specified name.

Configuration: Set measurement limits for tests
Use Configuration tab to view and configure the Global Settings and the measurement configurations. The measurement specific
configurations available in this tab depends on the selections made in the DUT panel and Test Selection panel.

Table 10: Configuration tab: Common parameters

Settings Description
Limits Editor Displays the upper and lower limits for the applicable measurement using different types of

comparisons.

Setup panel: Configure the test setup
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Figure 17: Configuration tab - Global Settings

Table 11: Configuration tab: Global settings

Settings Description
Instruments Detected Displays the instruments connected to this application. Click

on the instrument name to open a list of available (detected)
instruments.

Select Options > Instrument Control Settings to refresh the
connected instrument list refer TekExpress instrument control
settings on page 34

Use Cursors Select the cursor from the drop-down:

• Automatic: Displays the calculated results automatically.
• Manual: Application allows you to place the cursor on the

desired region of acquired waveform. The cursors are used
as the gating criteria for the measurement and provides the
report for measured value.

Note: This is not applicable for Test ID 1.2.21, 1.2.22,
1.3.3, 1.3.4, and 1.3.5 measurements.

Autoset For Vertical Settings
Insertion Loss Va Select to browse the filter file for respective Va, Vb, and Vc

Sources.

Note: This is applicable for Test ID 1.2.21 and 1.2.22

Vb
Vc

Table continued…

Setup panel: Configure the test setup

TekExpress® C-PHY Automated Test Software Application Help (70K Series MSO/DPO) 43



Settings Description
CTLE

Note: This is applicable for Test ID 1.2.21 and 1.2.22

CTLE File Path Select to browse the filter file for Continuous Time Linear
Equalizer.

Figure 18: Configuration tab - Measurements

Table 12: Configuration tab: Measurement settings

Settings Description
Measurements Displays the measurement groups, that are selected in the Test

Selection tab. Select the respective test group to view or modify the
measurement configuration.

Trigger settings
Trigger Type Transition Transition Time triggering allows you to trigger the time interval from

the low-to-high and/or high-to-low thresholds is slower (larger) than,
or faster (smaller) than a specified time, with Positive, Negative, or
Either polarity selected.

Edge Edge triggering is usually an adequate to give you a look at the
essential amplitude and timing characteristics of the waveform.

Width Width triggering allows you to accept (or reject) triggers, defined by
pulse widths that are between two defined time limits.

Source Source channel or waveform used to trigger or search. Types that
require multiple inputs will replace this control with a different source
definition control.

Table continued…
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Settings Description
Slope The slope controls provide the basic trigger point definition and

determine how a waveform is displayed
Level
Horizontal Settings Note: This setting is not applicable for Reference

Channels or UDA.

Record Length Specifies the waveform record length.
Sample Rate (GS/s) Specifies the oscilloscope's sample rate for all tests.
Vertical Settings Note: This setting is not applicable for Reference

Channels or UDA.

Data Vertical Scale (mV) Sets the Vertical Scale of the signal.
Vertical Position (div) Sets the Vertical Position of the signal.

Vertical Offset (V) Sets the channel signal vertical offset.

See also
Configure tests

About running tests

Preferences: Set the test run preferences
Use Preferences tab to set the application action on completion of a measurement. The Preferences tab has the feature to enable or
disable certain options related to the measurement execution.

Refer the below table for the options available in the Preferences tab:

Setup panel: Configure the test setup
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Table 13: Preferences tab settings

Setting Description
Execution Options
Acquire/Analyze each test <no> times (not applicable to Custom
Tests)

Select to repeat the test run by setting the number of times. By
default, the check box is enabled.

Note: This is not applicable for Pre-recorded Mode and
User Defined Acquisition.

Save data for initial <no> set of <type> waveforms Saves the set(s) of Pass/Fail waveforms to the session path.

Note: This is not applicable for Pre-recorded Mode and
User Defined Acquisition.

Enable Logging Select to record the actions of the user by the application. By
default, it is selected.

Note: Uncheck and Check this feature for the log to be
available in the session folder.

Actions on Test Measurement Failure
On Test Failure, stop and notify me of the failure Select to stop the test run on Test Failure, and to get notified via

email. By default, it is unselected. Click Email Settings to configure
the email settings to receive notifications.

Capture snapshot
Capture Analysis Region Snapshot Enables the Analysis region snapshot in the report.

Note: This is not applicable for Test ID 1.2.21, 1.2.22,
1.3.3, 1.3.4, and 1.3.5 measurements.

Setup panel: Configure the test setup
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Status panel: View the test execution status
The Status panel contains the Test Status and Log View tabs, which provides status on the test acquisition and analysis (Test Status) and
listing of test tasks performed (Log View tab). The application opens the Test Status tab when you start to execute the test. Select the
Test Status or the Log View tab to view these items while the test execution is in progress.

View test execution status
The tests are grouped and displayed based on the Clock and Data lane. It displays the tests along with the acquisition type, acquire, and
analysis status of the tests. In pre-recorded mode, Acquire Status is not valid.

The Test Status tab presents a collapsible table with information about each test as it is running. Use the symbols to expand ( ) and
collapse ( ) the table rows.

Figure 19: Test execution status view in Status panel

Table 14: Test execution status table headers

Table Header Description
Test Name Displays the measurement name.
Acquisition Describes the type of data being acquired.
Table continued…

Status panel: View the test execution status
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Table Header Description
Acquire Status Displays the progress state of the acquisition:

• To be started
• Inprogress
• Completed

Analysis Status Displays the progress state of the analysis:

• To be started
• Inprogress
• Completed

View test execution logs
The Test Status tab displays the detailed execution status of the tests. Also, displays each and every execution step in detail with its
timestamp information. The log details can be used to troubleshoot and resolve any issue/bug which is blocking the test execution process.

Figure 20: Log view in Status panel

Table 15: Status panel settings

Control Description
Message History Lists all the executed test operations and timestamp information.
Auto Scroll Enables automatic scrolling of the log view as information is added to the log during the test execution.

Clear Log Clears all the messages from the log view.
Table continued…

Status panel: View the test execution status
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Control Description
Save Saves the log file into a text file format. Use the standard Save File window to navigate to and specify

the folder and file name to save the log text.

Status panel: View the test execution status
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Results panel: View summary of test results

Figure 21: Results panel with measurement results

Click  icon on each measurement in the row to expand and to display the minimum and maximum parameter values of the
measurement.

Filter the test results
Each column in the result table can be customized and displayed by enabling or disabling any column as per your requirement. You can
change the view in the following ways:

• To remove or restore the Pass/Fail column, select Preferences > Show Pass/Fail.
• To collapse all expanded tests, select Preferences > View Results Summary.
• To expand all the listed tests, select View Results Details from the Preferences menu in the upper right corner.
• To enable or disable the wordwrap feature, select Preferences > Enable Wordwrap.
• To view the results grouped by lane or test, select the corresponding item from the Preferences menu.
• To expand the width of a column, place the cursor over the vertical line that separates the column from the column to the right. When

the cursor changes to a double-ended arrow, hold down the mouse button and drag the column to the desired width.
• To clear all test results displayed, click Clear.

Results panel: View summary of test results
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Reports panel: Configure report generation settings
Click Reports panel to configure the report generation settings and select the test result information to include in the report. You can use
the Reports panel to configure report generation settings, select test content to include in reports, generate the report, view the report,
browse for reports, name and save reports, and select report viewing options.

Report configuration settings
The Configuration tab describes the report generation settings to configure the Reports panel. Select report settings before running a test
or when creating and saving test setups. Report settings configured are included in saved test setups.

Figure 22: Report panel-Configuration tab details

Table 16: Report configuration panel settings

Control Description
View Click to view the most current report.
Generate Generates a new report based on the current analysis results.
Save As Specify a name for the report.
Report Update Mode Settings
Generate new report Each time when you click Run and when the test execution is complete, it will create a new

report. The report can be in either .mht, .pdf, or .csv file formats.
Append with previous run session Appends the latest test results to the end of the current test results report. Each time when

you click this option and run the tests, it will run the previously failed tests and replace the
failed test result with the new pass test result in the same report.

Include header in appended reports Select to include header in appended reports.
Table continued…

Reports panel: Configure report generation settings
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Control Description
Replace current test results Replaces the previous test results with the latest test results. Results from newly added

tests are appended to the end of the report.
In previous run, current session Select to replace current test results in the report with the test result(s) of previous run in

the current session.

In any run, any session Select to replace current test results in the report with the test result(s) in the selected run
session’s report. Click and select test result of any other run session.

Report Creation Settings
Report name Displays the name and path of the <Application Name> report. The default

location is at \My Documents>\My TekExpress\<Application
Name>\Reports. The report file in this folder gets overwritten each time you run
a test unless you specify a unique name or select to auto increment the report name.

To change the report name or location, do one of the following:

• In the Report Path field, type the current folder path and name.
• Double-click in the Report Path field and then make selections from the popup

keyboard and click Enter.

Be sure to include the entire folder path, the file name, and the file extension.
For example: C:\Documents and Settings\your user name\My
Documents\My TekExpress\<Application Name> \DUT001.mht.

Note: You cannot set the file location using the Browse button.

Open an existing report

Click Browse, locate and select the report file and then click View at the bottom of the
panel.

Save as type Saves a report in the specified file type, selected from the drop-down list. The report is
saved in .csv, .pdf, or .mht.

Note:

If you select a file type different from the default, be sure to change the report file
name extension in the Report Name field to match.

Auto increment report name if duplicate Sets the application to automatically increment the name of the report file if the application
finds a file with the same name as the one being generated. For example: DUT001,
DUT002, DUT003. This option is enabled by default.

Create report automatically at the end of the
run

Select to create the report with the settings configured, at the end of run.

View report after generating Automatically opens the report in a Web browser when the test execution is complete. This
option is selected by default.

Reports panel: Configure report generation settings
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Configure report view settings
The View Settings tab describes the report view settings to configure the Reports panel. Select report view settings before running a test
or when creating and saving test setups. Report settings configured are included in saved test setups.

Figure 23: Report panel-View settings tab

Table 17: Report panel view settings

Control Description
Contents To Save Settings
Include pass/fail info in details table Select to include pass/fail information in the details table of the report.
Include detailed results Select to include detailed results in the report.
Include plot images Select to include the plot images in the report.
Include setup configuration Sets the application to include hardware and software information in the summary box

at the top of the report. Information includes: the oscilloscope model and serial number,
the oscilloscope firmware version, and software versions for applications used in the
measurements.

Include complete application configuration Select to include the complete application configuration in the report.
Include user comments Select to include any comments about the test that you or another user have added in

the DUT tab of the Setup panel. Comments appear in the Comments section, below the
summary box at the beginning of each report.

Group Report By
Test Name Select to group the test results based on the test name in the report..
Test Result Select to group the test results based on the test result in the report.

Reports panel: Configure report generation settings
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View a generated report
Sample report and its contents
A report shows detailed results and plots, as set in the Reports panel.

Figure 24: Report of C-PHY

Setup Information The summary box at the beginning of the report lists setup configuration information. This information
includes the oscilloscope model and serial number, optical module model and serial number, and software
version numbers of all associated applications.
The test summary table lists all the tests which are executed with its result status.

Measurement The measurement table displays the measurement related details with its parameter value.
User comments If you had selected to include comments in the test report, any comments you added in the DUT tab are

shown at the top of the report. 

Note: To navigate to the plot click on the first row in the measurement table for each iteration.

Reports panel: Configure report generation settings
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Saving and recalling test setup

Test setup files overview
Saved test setup information (such as the selected oscilloscope, general parameters, acquisition parameters, measurement limits,
waveforms (if applicable), and other configuration settings) are saved under the setup name at X:\<Application Name>.

Use test setups to:

• Run a new session, acquire live waveforms, using a saved test configuration.
• Create a new test setup using an existing one.
• View all the information associated with a saved test, including the log file, the history of the test status as it executed, and the results

summary.
• Run a saved test using saved waveforms.

Save the configured test setup
You can save a test setup before or after running a test. You can create a test setup from already created test setup or using a default
test setup. When you save a setup, all the parameters, measurement limits, waveform files (if applicable), test selections, and other
configuration settings are saved under the setup name. When you select the default test setup, the parameters are set to the application’s
default value.

Select Options > Save Test Setup to save the opened setup.

Select Options > Save Test Setup As to save the setup with different name.

Load a saved test setup
To open (load) a saved test setup, do the following:

• Select Options > Open Test Setup.
• Select the setup from the list and click Open. Setup files are located at X:\<Application Name>.

Select a pre-run session from the loaded test setup
Complete the following steps to load a test setup from a pre-run session:

1. Select Options > Open Test Setup.
2. Select a setup from the list and then click Open. Setup files are located at X:\<Application Name>\.
3. Switch the mode to Pre-recorded waveform files in the DUT panel.
4. Select the required waveforms from the selected setup in the Acquisition tab and Run the required test.

Saving and recalling test setup
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Save the test setup with a different name
To create a test setup with a different name, follow the steps:

1. Select Options > Open Test Setup.
2. Select a setup from the list and then click Open.
3. Click application setup and modify the parameters.
4. Click application reports and modify the report options.
5. Select Options > Save Test Setup As.
6. Enter the test setup name and click Save.

Saving and recalling test setup
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Application measurements

1.1.1 Thevenin Output High Level Voltage (VOH)
CPHY-TX test verifies that Thevenin Output High Level Voltage (VOH) of the DUTs LP transmitter is within the conformance limits as per
MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with LP signaling sequence is captured from DUT
2. 400 MHz, 4th order Butterworth Lowpass test filter is applied to the acquired waveform.
3. LP-1 states are found and VOH is measured as mode of all samples which are greater than 50% of absolute peak-to-peak of VA.
4. Repeat Step 3 for VB and VC waveform.

1.1.2 LP-TX Thevenin Output Low Level Voltage (VOL)
This CPHY-TX test verifies that Thevenin Output High Level Voltage (VOH) of the DUTs LP transmitter is within the conformance limits as
per MIPI CPHY Specification.

Procedures
1. Using DSO, VA, VB, and VC signals with LP signaling sequence is captured from DUT.
2. 400 MHz, 4th order Butterworth Lowpass test filter is applied to the acquired waveform.
3. LP-0 states are found and VOH is measured as mode of all samples which are less than 50% of absolute peak-to-peak of VA.
4. Repeat Step 3 for VB and VC waveform.

1.1.3 LP-TX 15%-85% Rise Time (tRLP)
This CPHY-TX test verifies that 15%-85% Rise Time (tRLP) of the DUT’s LP transmitter is within the conformance limits as per MIPI CPHY
Specification.

Procedures
1. Using DSO, VA, VB, and VC signals with LP signaling sequence is captured from DUT.
2. LP regions are found from the acquired VA,VB, and VC waveform.
3. 400 MHz, 4th order Butterworth Lowpass test filter is applied to the acquired waveform.
4. Refer 1.1.1 Thevenin Output High Level Voltage (VOH) on page 57 and 1.1.2 LP-TX Thevenin Output Low Level Voltage

(VOL) on page 57 to calculate VOH and VOL.
5. Repeat Step 4 to Step 5 for VB and VC waveform.

1.1.4 LP-TX 15%-85% Fall Time (tFLP)
This CPHY-TX test verifies that 15%-85% Fall Time (tFLP) of the DUT’s LP transmitter is within the conformance limits as per MIPI CPHY
Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with LP signaling sequence is captured from DUT.
2. LP regions are found from the acquired VA,VB, and VC waveform.

Application measurements
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3. 400 MHz, 4th order Butterworth Lowpass test filter is applied to the acquired waveform.
4. Refer 1.1.1 Thevenin Output High Level Voltage (VOH) on page 57 and 1.1.2 LP-TX Thevenin Output Low Level Voltage

(VOL) on page 57 to calculate VOH and VOL.
5. Fall Time (tFLP) is measured as mean of 15%-85% fall time for VA across all falling edges of LP region found.
6. Repeat Step 4 to Step 5 for VB and VC waveform.

1.1.5 LP-TX Slew Rate versus CLOAD (dV/dtSR)
This CPHY-TX test verifies that slew rate (dV/dtSR) of the DUT’s LP transmitter is within the conformance limits as per MIPI CPHY
Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with LP signaling sequence is captured from DUT.
2. LP regions are found from the acquired VA,VB, and VC waveform.
3. 400 MHz, 4th order Butterworth Lowpass test filter is applied to the acquired waveform.
4. The maximum and minimum slew rate (dV/dtSR) for falling and rising edge is measured over desired region as per MIPI-CPHY CTS for

VA.
5. Repeat Step 4 for VB and VC waveform.

1.1.6 LP-TX pulse width of Exclusive-OR Clock (tLP-PULSE-TX)
This CPHY-TX test verifies that pulse width (tLP-PULSE-TX) of the DUT’s LP transmitter XOR clock is within the conformance limits as per
MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with LP signaling sequence is captured from DUT.
2. Mark1 and stop state are found from the acquired VA,VB, and VC waveform.
3. 400 MHz, 4th order Butterworth Lowpass test filter is applied to the acquired waveform.
4. XOR clock computed from VA and VC waveform.
5. Pulse width is measured for the XOR clock based on minimum and maximum trip level defined in MIPI-CPHY CTS.

1.1.7 LP-TX Period of Exclusive-OR Clock (tLP-PER-TX)
This CPHY-TX test verifies the period (tLP-PER-TX) of the DUT’s LP transmitter XOR clock is within the conformance limits as per MIPI
CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with LP signaling sequence is captured from DUT.
2. Mark1 and stop state are found from the acquired VA,VB and VC waveform.
3. 400 MHz, 4th order Butterworth Lowpass test filter is applied to the acquired waveform.
4. XOR clock computed from VA and VC waveform.
5. Period is measured for the XOR clock based on minimum and maximum trip level defined in MIPI-CPHY CTS.
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1.1.8 tLP-EXIT value
This CPHY-TX test verifies that tLP-EXIT of the DUT’s LP transmitter is within the conformance limits as per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with LP signaling sequence is captured from DUT.
2. tLP-EXIT interval is measured when VB rising edge crosses VIH_Min until VB falling edge VIL_Max up to the next sequence respectively.

1.2.1 tLPX Duration
This CPHY-TX test verifies that the duration (tLPX) of the final LP-001 state immediately before HS transmission is as per MIPI CPHY
Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with HS burst sequence is captured from DUT.
2. The desired LP region is found from the acquired waveforms.
3. tLPX duration is measured from the point where VA crosses below VIL_MAX till the point where VC crosses below VIL_MAX as

defined in MIPI CPHY CTS.

1.2.2 t3-PREPARE Duration
This CPHY-TX test verifies that the duration of the final LP-000 state immediately before HS transmission (t3-PREPARE) is as per MIPI
CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with HS burst sequence is captured from DUT.
2. The desired LP and HS regions are found from the acquired waveforms.
3. t3- PREPARE duration is measured from the point where VC crosses below VIL_MAX till the point where the VAB, VBC, and VCA

differential waveforms all cross above the minimum differential threshold level as defined in MIPI CPHY CTS.

1.2.3 t3-PREBEGIN Duration
This CPHY-TX test verifies that duration of t3-PREBEGIN is within the conformance limits as per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with HS burst sequence is captured from DUT.
2. The captured signal is decoded.
3. If t3-PROGSEQ is enabled, t3- PREBEGIN is measured from the start of HS burst (point where the VAB, VBC, and VCA differential

waveforms all cross above the minimum differential threshold level as defined in MIPI CPHY CTS) till start of t3-PROGSEQ.
4. Else, t3- PREBEGIN is measured from the start of HS burst (point where the VAB, VBC, and VCA differential waveforms all cross

above the minimum differential threshold level as defined in MIPI CPHY CTS) till start of t3-PREEND.

1.2.4 t3-PROGSEQ Duration
This CPHY-TX test verifies that duration of t3-PREBEGIN is within the conformance limits as per MIPI CPHY Specification.
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Procedure
1. Using DSO, VA, VB, and VC signals with HS burst sequence is captured from DUT.
2. The captured signal is decoded and t3- PROGSEQ sequence is read as input from user.
3. The given t3-PROGSEQ sequence is searched from the decoded bursts.

1.2.5 t3- PREEND Duration
This CPHY-TX test verifies that duration of t3- CALALTSEQ is within the conformance limits as per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with HS burst sequence is captured from DUT.
2. The captured signal is decoded, and t3-PREEND, which is “3,3,3,3,3,3,3” is found from the decoded burst.

1.2.6 t3-SYNC Duration
This CPHY-TX test verifies that duration of t3- SYNC is within the conformance limits as per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB & VC signals with HS burst sequence is captured from DUT.
2. The captured signal is decoded.
3. t3-SYNC Word, which is “3,4,4,4,4,4,3” is found from the decoded burst.

1.2.7 HS-TX Differential Voltages (VOD_AB, VOD_BC, VOD_CA)
This CPHY-TX test verifies that differential voltages (VOD_AB, VOD_BC, VOD_CA) of the DUT HS transmitter are within the conformance
limits as per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with HS signaling sequence is captured from DUT.
2. Mean value of maximum VOD_AB for the Strong 1, Weak 0 and mean value of minimum VOD_AB for the Weak 0, Strong 0 levels of

the AB pair are calculated as defined in MIPI-CPHY CTS.
3. Repeat Step 2 for VBC and VCA waveform.

1.2.8 HS-TX Differential Voltage Mismatch (ΔVOD)
This CPHY-TX test Differential Voltage Mismatch (ΔVOD) of the DUT HS transmitter is within the conformance limits per MIPI CPHY
Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with HS signaling sequence is captured from DUT.
2. Refer 1.2.7 HS-TX Differential Voltages (VOD_AB, VOD_BC, VOD_CA) on page 60 to obtain VOD value for VAB, VBC, VCA

differential pairs.
3. Differential voltage mismatch, ΔVOD is calculated as defined in MIPI-CPHY CTS.
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1.2.9 HS-TX Single-Ended Output High Voltages (VOHHS(VA), VOHHS(VB),
VOHHS(VC))
This CPHY-TX test verifies that single-Ended output high voltages (VOHHS(VA), VOHHS(VB), and VOHHS(VC)) of the DUT HS
transmitter are less than the maximum conformance limit as per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with HS signaling sequence is captured from DUT.
2. Values of VOHHS(VA), VOHHS(VB), and VOHHS(VC) are calculated as defined in MIPI-CPHY CTS similar to the test 1.2.7 HS-TX

Differential Voltages (VOD_AB, VOD_BC, VOD_CA) on page 60 using VA, VB and VC signals.

1.2.10 HS-TX Static Common-Point Voltages (VCPTX)
This CPHY-TX test verifies that Static Common-Point Voltages (VCPTX) of the DUT HS transmitter are within the conformance limits as
per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with HS signaling sequence is captured from DUT.
2. Mean values for VCPTX for each of the +x, +y, +z, -x, -y, and –z states are calculated as defined in MIPI-CPHY CTS.

1.2.11 HS-TX Static Common-Point Voltage Mismatch (ΔVCPTX(HS))
This CPHY-TX test verifies that Static Common-Point Voltage Mismatch (ΔVCPTX(HS)) of the DUT HS transmitter is within the
conformance limits as per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with HS signaling sequence is captured from DUT.
2. Refer 1.2.10 HS-TX Static Common-Point Voltages (VCPTX) on page 61to calculate static common-mode levels for VA, VB and VC

signals.
3. Static common-point voltage mismatch is calculated as defined in MIPI CPHY CTS.
4. Repeat Step 2 to Step 3 for all Lanes.

1.2.12 HS-TX Dynamic Common-Point Variations Between 50-450 MHz
(ΔVCPTX(LF))
This CPHY-TX test verifies that AC Common-Point Signal Level Variations between 50 and 450 MHz (ΔVCPTX(LF)) of the DUT HS
transmitter is within the conformance limits as per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with HS signaling sequence is captured from DUT.
2. Common-point voltage, VCPTX signal is computed and 8th-order Butterworth IIR bandpass filter with -3 dB cutoff frequencies of 50

MHz and 450 MHz is applied as defined in MIPI CPHY CTS.
3. The peak voltage of the bandpass-filtered VCPTX waveform is measured.
4. Repeat Step 2 to Step 5 for all Lanes.
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1.2.13 HS-TX Dynamic Common-Point Variations Above 450 MHz (ΔVCPTX(HF))
This CPHY-TX test verifies that AC Common-Mode Signal Level Variations above 450 MHz (ΔVCPTX(HF)) of the DUT HS transmitter is
within the conformance limits as per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with HS signaling sequence is captured from DUT.
2. Common-point voltage VCPTX signal is computed and 8th-order Butterworth highpass filter with cutoff frequencies of 450 MHz is

applied as defined in MIPI CPHY CTS.
3. The RMS value of the filtered VCPTX waveform is measured.

1.2.14 HS-TX Rise Time (tR)
This CPHY-TX test verifies that Rise Time (tR) of the DUT HS transmitter is within the conformance limits as per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with HS signaling sequence is captured from DUT.
2. The differential waveform is computed as difference of the VA and VB single-ended waveforms (VA-VB).
3. The averaged rise time waveform is computed for the strong zero to weak one transition.
4. Measure the Rise Time (tR) of the averaged reference waveform between the –58 and +58 mV levels.

1.2.15 HS-TX Fall Time (tF)
This CPHY-TX test verifies that Fall Time (tF)of the DUT HS transmitter is within the conformance limits as per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with HS signaling sequence is captured from DUT.
2. The differential waveform is computed as difference of the VA and VB single-ended waveforms (VA-VB).
3. The averaged Fall Time (tF) is measured for the weak one to strong zero transition.
4. Measure the Fall Time (tF) of the averaged reference waveform between the –58 and +58 mV levels.

1.2.16 t3-POST Duration
This CPHY-TX test verifies that duration of HS-TX burst (t3-POST), is within the conformance limits as per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with HS signaling sequence is captured from DUT.
2. The captured signal is decoded and length of t3- POST is read as input from user.
3. The t3-POST sequence (all 4’s) of given length is searched from the decoded bursts.

1.2.17 30%-85% Post-EoT Rise Time (tREOT)
This CPHY-TX test verifies that 30%-85% Post-EoT Rise Time (tREOT)), is within the conformance limits as per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with HS signaling sequence is captured from DUT.
2. The differential waveform is computed as difference of single-ended waveforms VA and VC (VC–VA).
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3. tREOT Rise Time is measured at the starting point where the differential waveform last crosses below the minimum valid HS-RX
differential threshold level (± 40 mV), until VA crosses VIH_MIN as defined in MIPI CPHY CTS.

1.2.18 tHS-EXIT Value
This CPHY-TX test verifies that duration of in the LP-111 (Stop) state, is within the conformance limits as per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with HS signaling sequence is captured from DUT.
2. tHS-EXIT interval for a given Lane is measured at the starting point which is from the end of the t3-POST interval until the VA (LP-001)

falling edge crosses VIL_MAX as defined in MIPI CPHY CTS.

1.2.19 HS Clock Instantaneous UI (UIINST)
This CPHY-TX test verifies that Instantaneous Unit Interval values (UIINST), is within the conformance limits as per MIPI CPHY
Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with HS signaling sequence is captured from DUT.
2. Differential waveforms are calculated to observe the zero crossings between each UI.
3. The UIINST values for each UI are measured as the difference between successive 0 V crossing times of the differential waveforms is

calculated as mentioned in MIPI CPHY CTS.

1.2 20 HS Clock Delta UI (ΔUI) (OBSOLETE)
This CPHY-TX test verifies that frequency stability of the DUT HS Clock during a single burst, is within the conformance limits as per MIPI
CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with HS signaling sequence is captured from DUT.
2. Differential waveforms Vab are calculated to observe the zero crossings between each UI.
3. Butterworth lowpass filter with a -3 dB cutoff frequency of 2.0 MHz is applied.
4. The HS Clock Delta UI (ΔUI) values for each UI are measured as The widths for each UI is measured as the difference between

successive 0 V crossing times of the differential waveforms.

1.2.21 HS-TX Eye Diagram
This CPHY-TX test verifies that Transmitter Eye Diagram, is within the conformance limits as per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with continuous pseudo random (PRBS9) HS test sequence is captured from DUT.
2. Capture at least 1 million UIs of the differential waveforms Vab from the HS sequence using the DSO
3. Generate RCLK
4. Reference channel and CTLE is applied on the differential waveform computed as required.

Note: Devices that operates at Symbol Rate greater than 4.5 Gsps (Short Reference Channel), greater than 3.5 Gsps
(Standard Reference Channel), greater than 2.3 Gsps (Long Reference Channel) continuity CTLE should be used.

5. Check for mask hit using Eye Diagram as described in MIPI CPHY CTS.
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6. Repeat Step 2 to Step 6 for VBC and VCA

1.2.22 HS-TX UI Jitter (UI_JitterPEAK_TX)
This CPHY-TX test verifies that Transmitter UI Jitter specification., is within the conformance limits as per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with continuous pseudo random (PRBS9) HS sequence is captured from DUT.
2. Capture l000 UIs of the differential waveforms Vab from the HS sequence.
3. Generate the RCLK.
4. 25 GHz low pass filter applied on RCLK signal before performing measurements.
5. Reference channel and CTLE is applied on the differential waveform computed as required.

Note: Devices that operates at Symbol Rate greater than 4.5 Gsps (Short Reference Channel), greater than 3.5 Gsps
(Standard Reference Channel), greater than 2.3 Gsps (Long Reference Channel) continuity CTLE should be used.

6. The peak-to-peak values of the histogram are reported as mentioned in MIPI CPHY CTS.
7. Repeat Step 2 to Step 5 for Vbc and Vca.

1.3.1 INIT: LP-TX Initialization Period (tINIT,MASTER)
This CPHY-TX test verifies that duration of the DUTs transmitted LP Initialization period (tINIT,MASTER) is within the conformance limits as
per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with LP signaling sequence is captured from DUT.
2. Desired LP region is found from the acquired VA,VB, and VC waveforms.
3. LP-111 initialization period is measured from the point where VA first crosses above VIH_MIN till the first point where VA crosses below

VIL_MAX as defined in MIPI-CPHY CTS.

1.3.2 ULPS Exit: Transmitted tWAKEUP Interval
This CPHY-TX test verifies that duration of the DUTs transmitted Mark-1 (tWAKEUP) when initiating a ULPS Exit sequence is within the
conformance limits as per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with ULPS entry sequence followed by a Mark-1 ULPS Exit sequence is captured from DUT.
2. Desired LP region is found from the acquired VA, VB, and VC waveforms.
3. The tWAKEUP is measured from the point where the VA line of LP-100 transition crosses VIH_MIN, to the point where the VC line of

LP-111 transition crosses VIH_MIN as defined in MIPI-CPHY CTS.

1.3.3 BTA: TX-Side tTA-GO Interval Value
This CPHY-TX test verifies that DUT drives the Bridge state (LP-000) for the proper period (tTA-GO) and is within the conformance limits as
per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with Turnaround sequence is captured from DUT.

Application measurements

TekExpress® C-PHY Automated Test Software Application Help (70K Series MSO/DPO) 64



2. The desired Link Turnaround sequence region is identified and recalled on DSO.
3. Measure the required LP-000 duration manually by placing the cursor on appropriate region as defined in MIPI-CPHY CTS.
4. TLPX Duration value is obtained (follow the procedure listed in the 1.2.1 tLPX Duration on page 59) which is updated in report for

reference under test comment as part of observable result.

1.3.4 BTA: RX-Side tTA-SURE Interval Value
This CPHY-TX test verifies that DUT waits the required period (tTA-SURE) while observing the TX-Side Bridge state (LP-000) and is within
the conformance limits as per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with Turnaround sequence is captured from DUT.
2. The desired Link Turnaround sequence region is identified and recalled on DSO.
3. Measure the required LP-000 duration manually by placing the cursor on appropriate region as defined in MIPI-CPHY CTS.
4. TLPX Duration value is obtained (follow the procedure listed in the 1.2.1 tLPX Duration on page 59) which is updated in report for

reference under test comment as part of observable result.

1.3.5 BTA: RX-Side tTA-GET Interval Value
This CPHY-TX test verifies that DUT drives the Bridge state (LP-000) for the required period (tTA-GET) and is within the conformance limits
as per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with Turnaround sequence is captured from DUT.
2. The desired Link Turnaround sequence region is identified and recalled on DSO.
3. Measure the required LP-000 duration manually by placing the cursor on appropriate region as defined in MIPI-CPHY CTS.
4. TLPX Duration value is obtained (follow the procedure listed in the 1.2.1 tLPX Duration on page 59) which is updated in report for

reference under test comment as part of observable result.

1.4.1 HS-TX Differential Voltages Unterminated (VOD(UT)-AB, VOD(UT)-BC, VOD(UT)-CA)
This CPHY-TX test verifies that Unterminated Differential Voltages (VOD(UT)-AB, VOD(UT)-BC, VOD(UT)-CA) of the DUT HS transmitter is within
the conformance limits as per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with HS signaling sequence is captured from DUT.
2. Mode value of maximum VOD(UT)-AB for the Strong 1, Weak 0 and minimum VOD(UT)-AB for the Weak 0, Strong 0 levels of the AB pair

are calculated as defined in MIPI-CPHY CTS.
3. Repeat Step 2 for VBC and VCA waveform.

1.4.2 HS-TX Differential Voltage Mismatch Unterminated (ΔVOD(UT))
This CPHY-TX test verifies that Unterminated Differential Voltage Mismatch (ΔVOD(UT)) of DUT HS transmitter is within the conformance
limits as per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with HS signaling sequence is captured from DUT.
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2. Refer 1.4.1 HS-TX Differential Voltages Unterminated (VOD(UT)-AB, VOD(UT)-BC, VOD(UT)-CA) on page 65 to obtain the VODUT
value for VAB, VBC, and VCA differential pairs.

3. Differential voltage mismatch (ΔVOD) is calculated as defined in MIPI-CPHY CTS.

1.4.3 HS-TX Single-Ended Output High Voltages Unterminated (VOHHS(UT)(VA),
VOHHS(UT)(VB),VOHHS(UT)(VC))
This CPHY-TX test verifies that Unterminated Single-Ended Output High Voltages (VOHHS(UT)(VA), VOHHS(UT)(VB), and VOHHS(UT)(VC)) of the
DUT HS transmitter is within the conformance limits as per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with HS signaling sequence is captured from DUT.
2. Refer 1.4.1 HS-TX Differential Voltages Unterminated (VOD(UT)-AB, VOD(UT)-BC, VOD(UT)-CA) on page 65 to calculate the mode

value of VOHHS(UT)(VA), VOHHS(UT)(VB), and VOHHS(UT)(VC) as defined in MIPI-CPHY CTS.

1.4.4 HS-TX Static Common-Point Voltages Unterminated (VCPTX(UT))
This CPHY-TX test verifies that Static Common-Point Voltages (VCPTX(UT)) of DUT HS transmitter is within the conformance limits as per
MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with HS signaling sequence is captured from DUT.
2. Mean values for VCPTX(UT) for each of the +x, +y, +z, -x, -y, and –z states are calculated as defined in MIPI-CPHY CTS.

1.5.1 t3-CALPREAMBLE Duration (Informative)
This CPHY-TX test verifies that duration of t3-CALPREAMBLE is within the conformance limits as per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with HS burst sequence containing Format 1 Calibration Preamble is captured from DUT.
2. t3-CALPREAMBLE is measured from start of HS Burst (point where all 3 differential signals: VAB, VBC, VCA cross above the minimum

threshold ± 40 mV) till the start of t3-SYNC Word.
3. The captured signal is decoded, and t3-SYNC Word position is found from the decoded burst.
4. t3-CALPREAMBLE duration is measured from start of the HS burst to start of t3-SYNC Word. It is also verified that t3- CALPREAMBLE

contains all 1’s.

1.5.2 t3-ASID Duration (Informative)
This CPHY-TX test verifies that duration of t3-ASID is within the conformance limits as per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with HS burst sequence containing Format 2 Calibration Preamble is captured from DUT.
2. The captured signal is decoded, and t3-ASID, which is “3,3,3,3,3,3,3” is found from the decoded burst.

1.5.3 t3-CALALTSEQ Duration (Informative)
This CPHY-TX test verifies that duration of t3- CALALTSEQ is within the conformance limits as per MIPI CPHY Specification.
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Procedure
1. Using DSO, VA, VB, and VC signals with HS burst sequence containing Format 2 Calibration Preamble is captured from DUT.
2. The captured signal is decoded.
3. t3-SYNC Word position and t3-ASID position is found from the decoded burst.
4. t3- CALALTSEQ is measured from end of the t3- ASID to start of t3-SYNC Word. It is also verified that t3- CALALTSEQ length is a

multiple of 7UI.

1.5.4 Calibration Sequence t3-SYNC Duration (Informative)
This CPHY-TX test verifies that duration of t3- SYNC is within the conformance limits as per MIPI CPHY Specification.

Procedure
1. Using DSO, VA, VB, and VC signals with HS burst sequence containing Format 1 Calibration Preamble is captured from DUT.
2. The captured signal is decoded.
3. t3-SYNC Word, which is “3,4,4,4,4,4,3” is found from the decoded burst.
4. Repeat the procedure for Format 2 Calibration Preamble.
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SCPI Commands

About SCPI command
You can use the Standard Commands for Programmable Instruments (SCPI) to communicate remotely with the TekExpress application.
Complete the TCPIP socket configuration and the TekVISA configuration in the oscilloscope or in the device where you are executing the
script.

Note: If you are using an external PC to execute the remote interface commands, then install TekVISA in the PC to make the
configurations.

Socket configuration for SCPI commands
This section describes the steps to configure the TCPIP socket configuration in your script execution device and the steps to configure the
TekVISA configuration in the oscilloscope to execute the SCPI commands.

TCPIP socket configuration
1. Click Start > Control Panel > System and Security > Windows Firewall > Advanced settings.

2. In Windows Firewall with Advanced Security menu, select Windows Firewall with Advanced Security on Local Computer >
Inbound Rules and click New Rule…
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3. In New Inbound Rule Wizard menu

a. Select Port and click Next.

b. Select TCP as rule apply, enter 5000 for Specific local ports and click Next.
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c. Select Allow the connection and click Next.

d. Select Domain, Private, Public checkbox and click Next.
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e. Enter Name, Description (optional), and click Finish.

4. Check whether the Rule name is displayed in Windows Firewall with Advanced Security menu > Inbound Rules.
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TekVISA configuration
1. Click Start > All Programs > TekVISA > OpenChoice Instrument Manager.

2. Click Search Criteria. In Search Criteria menu, click LAN to Turn-on. Select Socket from the drop-down list, enter the IP address of

the TekExpress device in Hostname and type Port as 5000. Click  to configure the IP address with Port.

Enter the Hostname as 127.0.0.1 if the TekVISA and TekExpress application are in the same system, else enter the IP address of the
oscilloscope where the TekExpress application is running.

SCPI Commands

TekExpress® C-PHY Automated Test Software Application Help (70K Series MSO/DPO) 72



3. Click Search to setup the TCPIP connection with the host. Check whether the TCPIP host name is displayed in OpenChoice
Instrument Manager > Instruments.

4. Double-click OpenChoice Talker Listener and enter the Command *IDN? in command entry field and click Query. Check that the
Operation is successful and Talker Listener Readout displays the Command / Data.
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Set or query the device name of application
This command sets or queries the device name of the application.

Syntax
TEKEXP:SELECT DEVICE,"<DeviceName>" (Set)

TEKEXP:SELECT? DEVICE (Query)

Command arguments
Argument Name Argument Type
<DeviceName> <String>

Returns
<String>

Examples
TEKEXP:SELECT DEVICE,"<DUT001>" command sets the device name of the application to DUT001.

TEKEXP:SELECT? DEVICE command returns the selected device name of the application.

Set or query the DUTID of application
This command sets or queries the DUTID of the application.

Syntax
TEKEXP:VALUE DUTID,"<Value>" (Set)

TEKEXP:VALUE? DUTID (Query)
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Command arguments
Argument Name Argument Type
<Value> <String>

Returns
<String>

Examples
TEKEXP:VALUE DUTID,"DUT001" command sets the DUTID of the application to DUT001.

TEKEXP:VALUE? DUTID command returns the DUTID of the application.

Set or query the suite name of the application
This command sets or queries the suite name of the application.

Syntax
TEKEXP:SELECT SUITE,"<SuiteName>" (Set)

TEKEXP:SELECT? SUITE (Query)

Command arguments
Returns
<String>

Examples
TEKEXP:SELECT SUITE,"<SuiteName>" command sets the suite name of the application.

TEKEXP:SELECT? SUITE command returns the selected suite of the application.

Set or query the test name of the application
This command selects or deselects the specified test name of the application.

Syntax
TEKEXP:SELECT TEST,"<TestName>",<Value> (Set)

TEKEXP:SELECT TEST,"<ALL>" (Set)

TEKEXP:SELECT? TEST (Query)

Command arguments
TestName Value
C-PHY 1.1

• Test 1.1.1 LP-TX Thevenin Output High Level Voltage (VOH)
• Test 1.1.2 LP-TX Thevenin Output Low Level Voltage (VOL)
• Test 1.1.3 LP-TX 15%-85% Rise Time (tRLP)

{True | False} or {1 | 0}

It represents selected or unselected.

Where,

True or 1 - Selected

Table continued…
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TestName Value

• Test 1.1.4 LP-TX 15%-85% Fall Time (tFLP)
• Test 1.1.5 LP-TX Slew Rate vs. CLOAD (dV_dtSR)
• Test 1.1.6 LP-TX Pulse Width of Exclusive-OR Clock (tLP-PULSE-TX)
• Test 1.1.7 LP-TX Period of Exclusive-OR Clock (tLP-PER-TX)
• Test 1.2.1 LP_TX tLPX Duration
• Test 1.2.2 LP_TX t3-PREPARE Duration
• Test 1.2.3 LP_TX t3-PREBEGIN Duration
• Test 1.2.4 LP_TX t3-PROGSEQ Duration
• Test 1.2.5 LP_TX t3-PREEND Duration
• Test 1.2.6 LP_TX t3-SYNC Duration
• Test 1.2.7 HS-TX Differential Voltages (VOD_AB, VOD_BC, VOD_CA)
• Test 1.2.8 HS-TX Differential Voltage Mismatch (Delta_VOD)
• Test 1.2.9 HS-TX Single-Ended Output High Voltages

(VOHHS(VA),VOHHS(VB),VOHHS(VC))
• Test 1.2.10 HS-TX Static Common-Point Voltages (VCPTX)
• Test 1.2.11 HS-TX Static Common-Point Voltage Mismatch (Delta VCPTX(HS))
• Test 1.2.12 HS-TX Dynamic Common-Point Variations Between 50-450MHz (Delta

VCPTX(LF))
• Test 1.2.13 HS-TX Dynamic Common-Point Variations Above 450MHz (Delta

VCPTX(HF))
• Test 1.2.16 HS_TX t3-POST Duration
• Test 1.2.17 HS_TX Post-EoT Rise Time(tREOT)
• Test 1.2.18 HS_TX tHS-EXIT Value
• Test 1.2.19 HS Clock Instantaneous UI (UIINST)
• Test 1.2.20 HS Clock Delta UI (Delta_UI)
• Test 1.2.21 HS-TX Eye Diagram
• Test 1.3.1 INIT LP-TX Initialization Period (tINIT,MASTER)
• Test 1.3.2 ULPS Exit Transmitted tWAKEUP Interval
• Test 1.3.3 BTA TX-Side tTA-GO Interval Value
• Test 1.3.4 BTA RX-Side tTA-SURE Interval Value
• Test 1.3.5 BTA RX-Side tTA-GET Interval Value
• Test 1.4.1 HS-TX Differential Voltages Unterminated (VOD(UT)-AB, VOD(UT)-BC,

VOD(UT)-CA)
• Test 1.4.2 HS-TX Differential Voltages Mismatch Unterminated (Delta_VOD(UT))
• Test 1.4.3 HS-TX Single-Ended Output High Voltages Unterminated

(VOHHS(VA),VOHHS(VB),VOHHS(VC))
• Test 1.4.4 HS-TX Static Common-Point Voltages Unterminated (VCPTX(UT))

False or 0 - Unselected

C-PHY 2.0

• Test 1.1.1 LP-TX Thevenin Output High Level Voltage (VOH)
• Test 1.1.2 LP-TX Thevenin Output Low Level Voltage (VOL)

{True | False} or {1 | 0}

It represents selected or unselected.

Where,

Table continued…
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TestName Value

• Test 1.1.3 LP-TX 15%-85% Rise Time (tRLP)
• Test 1.1.4 LP-TX 15%-85% Fall Time (tFLP)
• Test 1.1.5 LP-TX Slew Rate vs. CLOAD (dV_dtSR)
• Test 1.1.6 LP-TX Pulse Width of Exclusive-OR Clock (tLP-PULSE-TX)
• Test 1.1.7 LP-TX Period of Exclusive-OR Clock (tLP-PER-TX)
• Test 1.1.8 LP-TX tLP-EXIT Value
• Test 1.2.1 LP_TX tLPX Duration
• Test 1.2.2 LP_TX t3-PREPARE Duration
• Test 1.2.3 LP_TX t3-PREBEGIN Duration
• Test 1.2.4 LP_TX t3-PROGSEQ Duration
• Test 1.2.5 LP_TX t3-PREEND Duration
• Test 1.2.6 LP_TX t3-SYNC Duration
• Test 1.2.7 HS-TX Differential Voltages (VOD_AB, VOD_BC, VOD_CA)
• Test 1.2.8 HS-TX Differential Voltage Mismatch (Delta_VOD)
• Test 1.2.9 HS-TX Single-Ended Output High Voltages

(VOHHS(VA),VOHHS(VB),VOHHS(VC))
• Test 1.2.10 HS-TX Static Common-Point Voltages (VCPTX)
• Test 1.2.11 HS-TX Static Common-Point Voltage Mismatch (Delta VCPTX(HS))
• Test 1.2.12 HS-TX Dynamic Common-Point Variations Between 50-450MHz (Delta

VCPTX(LF))
• Test 1.2.13 HS-TX Dynamic Common-Point Variations Above 450MHz (Delta

VCPTX(HF))
• Test 1.2.16 HS_TX t3-POST Duration
• Test 1.2.17 HS_TX Post-EoT Rise Time(tREOT)
• Test 1.2.18 HS_TX tHS-EXIT Value
• Test 1.2.19 HS Clock Instantaneous UI (UIINST)
• Test 1.2.21 HS-TX Eye Diagram
• Test 1.2.22 HS-TX UI Jitter (UI_JitterPEAK_TX)
• Test 1.3.1 INIT LP-TX Initialization Period (tINIT,MASTER)
• Test 1.3.2 ULPS Exit Transmitted tWAKEUP Interval
• Test 1.3.3 BTA TX-Side tTA-GO Interval Value
• Test 1.3.4 BTA RX-Side tTA-SURE Interval Value
• Test 1.3.5 BTA RX-Side tTA-GET Interval Value
• Test 1.4.1 HS-TX Differential Voltages Unterminated (VOD(UT)-AB, VOD(UT)-BC,

VOD(UT)-CA)
• Test 1.4.2 HS-TX Differential Voltages Mismatch Unterminated (Delta_VOD(UT))
• Test 1.4.3 HS-TX Single-Ended Output High Voltages Unterminated

(VOHHS(VA),VOHHS(VB),VOHHS(VC))
• Test 1.4.4 HS-TX Static Common-Point Voltages Unterminated (VCPTX(UT))
• Test 1.5.1 t3-CALPREAMBLE Duration
• Test 1.5.2 t3-ASID Duration

True or 1 - Selected

False or 0 - Unselected
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TestName Value

• Test 1.5.3 t3-CALALTSEQ Duration
• Test 1.5.4 Calibration Sequence t3-SYNC Duration

C-PHY 1.0

• Test 1.1.1 LP-TX Thevenin Output High Level Voltage (VOH)
• Test 1.1.2 LP-TX Thevenin Output Low Level Voltage (VOL)
• Test 1.1.3 LP-TX 15%-85% Rise Time (tRLP)
• Test 1.1.4 LP-TX 15%-85% Fall Time (tFLP)
• Test 1.1.5 LP-TX Slew Rate vs. CLOAD (dV_dtSR)
• Test 1.1.6 LP-TX Pulse Width of Exclusive-OR Clock (tLP-PULSE-TX)
• Test 1.1.7 LP-TX Period of Exclusive-OR Clock (tLP-PER-TX)
• Test 1.2.1 LP_TX tLPX Duration
• Test 1.2.2 LP_TX t3-PREPARE Duration
• Test 1.2.3 LP_TX t3-PREBEGIN Duration
• Test 1.2.4 LP_TX t3-PROGSEQ Duration
• Test 1.2.5 LP_TX t3-PREEND Duration
• Test 1.2.6 LP_TX t3-SYNC Duration
• Test 1.2.7 HS-TX Differential Voltages (VOD_AB, VOD_BC, VOD_CA)
• Test 1.2.8 HS-TX Differential Voltage Mismatch (Delta_VOD)
• Test 1.2.9 HS-TX Single-Ended Output High Voltages

(VOHHS(VA),VOHHS(VB),VOHHS(VC))
• Test 1.2.10 HS-TX Static Common-Point Voltages (VCPTX)
• Test 1.2.11 HS-TX Static Common-Point Voltage Mismatch (Delta VCPTX(HS))
• Test 1.2.12 HS-TX Dynamic Common-Point Variations Between 50-450MHz (Delta

VCPTX(LF))
• Test 1.2.13 HS-TX Dynamic Common-Point Variations Above 450MHz (Delta

VCPTX(HF))
• Test 1.2.14 HS-TX Rise Time (tR)
• Test 1.2.15 HS-TX Fall Time (tF)
• Test 1.2.16 HS_TX t3-POST Duration
• Test 1.2.17 HS_TX Post-EoT Rise Time(tREOT)
• Test 1.2.18 HS_TX tHS-EXIT Value
• Test 1.2.19 HS Clock Instantaneous UI (UIINST)
• Test 1.2.20 HS Clock Delta UI (Delta_UI)
• Test 1.3.1 INIT LP-TX Initialization Period (tINIT,MASTER)
• Test 1.3.2 ULPS Exit Transmitted tWAKEUP Interval
• Test 1.3.3 BTA TX-Side tTA-GO Interval Value
• Test 1.3.4 BTA RX-Side tTA-SURE Interval Value
• Test 1.3.5 BTA RX-Side tTA-GET Interval Value

{True | False} or {1 | 0}

It represents selected or unselected.

Where,

True or 1 - Selected

False or 0 - Unselected

Returns
{True | False} or {1 | 0}
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Examples
TEKEXP:SELECT TEST,"<TestName>",1 command selects the specified test in the Test Panel.

TEKEXP:SELECT TEST,"<ALL>" command select all the tests in the Test Panel.

TEKEXP:SELECT? TEST command returns the list of selected tests.

Set or query the version name of the application
This command sets or queries the version name of the application.

Syntax
TEKEXP:SELECT VERSION,”<VersionName>” (Set)

TEKEXP:SELECT? VERSION (Query)

Command arguments
Argument Name Argument Type Valid Values
<VersionName> <String> It is the name of the version on the DUT panel of the application.

VersionName

• C-PHY 1.0
• C-PHY 1.1
• C-PHY 2.0

Returns
<String>

Examples
TEKEXP:SELECT VERSION,”<VersionName>” command sets the version name of application.

TEKEXP:SELECT? VERSION command returns the version name of application.

Set or query the general parameter values
This command sets or queries the general parameter values of the application.

Syntax
TEKEXP:VALUE GENERAL,"<ParameterName>","<Value>" (Set)

TEKEXP:VALUE? GENERAL,"<ParameterName>" (Query)

Command arguments
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Table 18: General command parameters

ParameterName Value
LVHS Mode • TRUE

• FALSE

LVLP Mode • TRUE
• FALSE

Termination Voltage (V) 0 to 5
Cursor Mode • Automatic

• Manual

Data Rate 0.08 to 8
Signal Types • HS

• LP
• LP-HS

Insertion Loss Selection • TRUE
• FALSE

CTLE Selection • TRUE
• FALSE

CTLE File PathC-PHY 1.1 • For C-PHY 1.1:

C:\Program Files\Tektronix\TekExpress\TekExpress
C-PHY\Compliance Suites\C-PHY\TX-Device\C-PHY
1.1\CTLE\CTLE_8Gsps.flt

• C-PHY 2.0

C:\Program Files\Tektronix\TekExpress\TekExpress
C-PHY\Compliance Suites\C-PHY\TX-Device\C-PHY
2.0\CTLE\CTLE_8Gsps.flt

Va Filter File Path • C-PHY 1.1

C:\Program Files\Tektronix\TekExpress\TekExpress
C-PHY\Compliance Suites\C-PHY\TX-Device\C-PHY
1.1\Standard_VAB.flt

• C-PHY 2.0

C:\Program Files\Tektronix\TekExpress\TekExpress
C-PHY\Compliance Suites\C-PHY\TX-Device\C-PHY
2.0\Standard_VAB.flt

Table continued…
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ParameterName Value
Vb Filter File Path • C-PHY 1.1

C:\Program Files\Tektronix\TekExpress\TekExpress
C-PHY\Compliance Suites\C-PHY\TX-Device\C-PHY
1.1\Standard_VBC.flt

• C-PHY 2.0

C:\Program Files\Tektronix\TekExpress\TekExpress
C-PHY\Compliance Suites\C-PHY\TX-Device\C-PHY
2.0\Standard_VBC.flt

Vc Filter File Path • C-PHY 1.1

C:\Program Files\Tektronix\TekExpress\TekExpress
C-PHY\Compliance Suites\C-PHY\TX-Device\C-PHY
1.1\Standard_VCA.flt

• C-PHY 2.0

C:\Program Files\Tektronix\TekExpress\TekExpress
C-PHY\Compliance Suites\C-PHY\TX-Device\C-PHY
2.0\Standard_VCA.flt

Enable Logging • TRUE
• FALSE

Acquisition Save Options Save All Waveforms Before Analysis
Number Lane • Lane0

• Lane1
• Lane2
• Lane3

SourceVA • CH1
• CH2
• CH3
• CH4

SourceVB • CH1
• CH2
• CH3
• CH4

SourceVC • CH1
• CH2
• CH3
• CH4

Number of Runs 1 to 1000
Table continued…
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ParameterName Value
On Failure Stop and Notify • TRUE

• FALSE

Save Number Of Waveform 1 to 30 (Available only when Suite=C-PHY 2.0)
Result Type (Available only when Suite=C-PHY 2.0)

• FAIL
• ALL

Autoset - For Vertical Settings (Available only when Suite=C-PHY 2.0)

• TRUE
• FALSE

Table 19: Report panel command parameters

<ParameterName> <Value>
On Test Failure, stop and notify me of the failure {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Report Update Mode • New
• Append
• Replace

Report Path X:\<application name>\Reports\DUT001.mht

Save As Type • Web Archive (*.mht;*.mhtml)
• PDF (*.pdf;)
• CSV (*.csv;)

Auto increment report name if duplicate {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Table continued…
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<ParameterName> <Value>
Create report at the end {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Include Pass/Fail Results Summary {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Include Detailed Results {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Include Plot Images {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Include Setup Configuration {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Include Complete Application Configuration {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Table continued…
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<ParameterName> <Value>
Include User Comments {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Report Settings:Include Header In Appended Reports {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

View Report After Generating {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Report Group Mode • Test Name
• Test Result

Append Report {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Returns
<NRf> or <String>

Examples
TEKEXP:VALUE GENERAL,"<ParameterName>","<Value>" command set the value for the specified general
parameter.

TEKEXP:VALUE? GENERAL,"<ParameterName>" command returns the value for the specified general parameter.
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Set or query the acquire parameter values
This command sets or queries the acquire parameter values of the application.

Syntax
TEKEXP:VALUE
ACQUIRE,”<TestName>",”<AcquireType>”,”<ParameterName>","<ParameterValue>" (Set)

TEKEXP:VALUE? ACQUIRE,”<TestName>",”<AcquireType>”,”<ParameterName>" (Query)

Command arguments
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TestName AcquireType ParameterName ParameterValue

1.1.1 Thevenin Output High
Level Voltage (VOH)

1.1.2 LP-TX Thevenin Output
Low Level Voltage (VOL)

1.1.3 LP-TX 15%-85% Rise Time
(tRLP)

1.1.4 LP-TX 15%-85% Fall Time
(tFLP)

1.1.5 LP-TX Slew Rate vs.
CLOAD (dV/dtSR)

1.1.6 LP-TX Pulse Width
of Exclusive-OR Clock (tLP-
PULSE-TX)

1.1.7 LP-TX Period of Exclusive-
OR Clock (tLP-PER-TX)

1.1.8 tLP-EXIT Value

LP_ULPS Vertical Scale (mV) 10 to 500
Vertical Position (div) -5 to 5
Vertical Offset (V) -1.3 to 1.3
Sample Rate (GS/s) • 6.25

• 12.5
• 25
• 50

Record Length 100000 to 10000000
Trigger Type • Transition

• Edge
• Width

Trigger Source • VA
• VB
• VC

Trigger Upper Level (V) -5 to 5
Trigger Lower Level (V) -6 to 1
Trigger Upper Limit (us)
Trigger Lower Limit (us)
Trigger Polarity • Positive

• Negative

Edge Trigger Level(V) 0 to 1
Trigger Time (ps) • 250

• 500

Trigger Transition • Less Than
• Greater Than

Trigger Slope • Positive
• Negative
• Either

Trigger If Violation • Occurs
• Logic
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TestName AcquireType ParameterName ParameterValue

1.2.1 tLPX Duration

1.2.2 t3-PREPARE Duration

1.2.3 t3-PREBEGIN Duration

1.2.16 t3-POST Duration

1.2.17 30%-85% Post-EoT
RiseTime (tREOT)

1.2.18 tHS-EXIT Value

LPHS_Timing Vertical Scale (mV) 10 to 500
Vertical Position (div) -5 to 5
Vertical Offset (V) -1.3 to 1.3
Sample Rate (GS/s) • 6.25

• 12.5
• 25
• 50
• AUTO

Record Length 100000 to 10000000
Trigger Type • Transition

• Edge
• Width

Trigger Source • VA
• VB
• VC

Trigger Upper Level (V) -5 to 5
Trigger Lower Level (V) -6 to 1
Trigger Upper Limit (us)
Trigger Lower Limit (us)
Trigger Polarity • Positive

• Negative

Edge Trigger Level(V) 0 to 1
Trigger Time (ps) • 250

• 500

Trigger Transition • Less Than
• Greater Than

Trigger Slope • Positive
• Negative
• Either

Trigger If Violation • Occurs
• Logic

Table continued…
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TestName AcquireType ParameterName ParameterValue

1.2.4 t3-PROGSEQ Duration

1.2.5 t3-PREEND Duration

1.2.6 t3-SYNC Duration

1.2.7 HS-TX Differential Voltages
(VOD_AB, VOD_BC, VOD_CA)

1.2.8 HS-TX Differential Voltage
Mismatch (Delta_VOD)

1.2.9 HS-TX Single-Ended
Output High Voltages
(VOHHS(VA),VOHHS(VB),VOHH
S(VC))

1.2.10 HS-TX Static Common-
Point Voltages (VCPTX)

1.2.11 HS-TX Static Common-
Point Voltage Mismatch (Delta
VCPTX(HS))

1.2.12 HS-TX Dynamic
Common-Point Variations
Between 50-450MHz (Delta
VCPTX(LF))

1.2.13 HS-TX Dynamic
Common-Point Variations Above
450MHz (Delta VCPTX(HF))

1.2.14 HS-TX Rise Time (tR)

1.2.15 HS-TX Fall Time (tF)

1.2.19 HS Clock Instantaneous
UI (UIINST)

1.2.20 HS Clock Delta UI
(Delta_UI)

HS_Timing_Voltage Vertical Scale (mV) 10 to 500
Vertical Position (div) -5 to 5
Vertical Offset (V) -1.3 to 1.3
Sample Rate (GS/s) • 6.25

• 12.5
• 25
• 50
• AUTO

Record Length 100000 to 10000000
Trigger Type • Transition

• Edge
• Width

Trigger Source • VA
• VB
• VC

Trigger Upper Level (V) -5 to 5
Trigger Lower Level (V) -6 to 1
Trigger Upper Limit (us)
Trigger Lower Limit (us)
Trigger Polarity • Positive

• Negative

Edge Trigger Level(V) 0 to 1
Trigger Time (ps) • 250

• 500

Trigger Transition • Less Than
• Greater Than

Trigger Slope • Positive
• Negative
• Either

Trigger If Violation • Occurs
• Logic

Table continued…
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TestName AcquireType ParameterName ParameterValue
1.2.21 HS-TX Eye Diagram HS_EYE Termination Voltage (V) 0 to 5

Vertical Scale (mV) 10 to 500
Vertical Position (div) -3 to 3
Vertical Offset (V) -1.3 to 1.3
Sample Rate (GS/s) • 6.25

• 12.5
• 25
• 50
• AUTO

Record Length 100000 to 10000000
Trigger Type • Transition

• Edge
• Width

Trigger Source • VA
• VB
• VC

Trigger Upper Level (V) -5 to 5
Trigger Lower Level (V) -6 to 1
Trigger Upper Limit (us)
Trigger Lower Limit (us)
Trigger Polarity • Positive

• Negative

Edge Trigger Level(V) 0 to 1
Trigger Time (ps) • 250

• 500

Trigger Transition • Less Than
• Greater Than

Trigger Slope • Positive
• Negative
• Either

Trigger If Violation • Occurs
• Logic

Number of UI 100 to 2000000
Table continued…
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TestName AcquireType ParameterName ParameterValue
1.2.22 HS-TX UI Jitter
(UI_JitterPEAK_TX)

HS_JITTER Termination Voltage (V) 0 to 5
Vertical Scale (mV) 10 to 500
Vertical Position (div) -5 to 5
Vertical Offset (V) -1.3 to 1.3
Sample Rate (GS/s) • 6.25

• 12.5
• 25
• 50
• AUTO

Record Length 100000 to 10000000
Trigger Type • Transition

• Edge
• Width

Trigger Source • VA
• VB
• VC

Trigger Upper Level (V) -5 to 5
Trigger Lower Level (V) -6 to 1
Trigger Upper Limit (us)
Trigger Lower Limit (us)
Trigger Polarity • Positive

• Negative

Edge Trigger Level(V) 0 to 1
Trigger Time (ps) • 250

• 500

Trigger Transition • Less Than
• Greater Than

Trigger Slope • Positive
• Negative
• Either

Trigger If Violation • Occurs
• Logic
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TestName AcquireType ParameterName ParameterValue

1.3.1 INIT: LP-TX Initialization
Period (tINIT,MASTER)

LP_INIT_Period Vertical Scale (mV) 10 to 500
Vertical Position (div) -5 to 5
Vertical Offset (V) -1.3 to 1.3
Sample Rate (GS/s) • 3.125

• 6.25
• 12.5
• 25
• 50

Record Length 100000 to 50000000
Trigger Type • Transition

• Edge
• Width

Trigger Source • VA
• VB
• VC

Trigger Upper Level (V) -5 to 5
Trigger Lower Level (V) -6 to 1
Trigger Upper Limit (us)
Trigger Lower Limit (us)
Trigger Polarity • Positive

• Negative

Edge Trigger Level(V) 0 to 1
Trigger Time (ps) • 250

• 500

Trigger Transition • Less Than
• Greater Than

Trigger Slope • Positive
• Negative
• Either

Trigger If Violation • Occurs
• Logic

Table continued…
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TestName AcquireType ParameterName ParameterValue

1.3.2 ULPS Exit: Transmitted
tWAKEUP Interval

LP_WAKEUP Vertical Scale (mV) 10 to 500
Vertical Position (div) -5 to 5
Vertical Offset (V) -1.3 to 1.3
Sample Rate (GS/s) • 3.125

• 6.25
• 12.5
• 25
• 50

Record Length 100000 to 50000000
Trigger Type • Transition

• Edge
• Width

Trigger Source • VA
• VB
• VC

Trigger Upper Level (V) -5 to 5
Trigger Lower Level (V) -6 to 1
Trigger Upper Limit (us)
Trigger Lower Limit (us)
Trigger Polarity • Positive

• Negative

Edge Trigger Level(V) 0 to 1
Trigger Time (ps) • 250

• 500

Trigger Transition • Less Than
• Greater Than

Trigger Slope • Positive
• Negative
• Either

Trigger If Violation • Occurs
• Logic

Table continued…
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TestName AcquireType ParameterName ParameterValue

1.3.3 BTA: TX-Side tTA-GO
Interval Value

1.3.4 BTA: RX-Side tTA-SURE
Interval Value

1.3.5 BTA: RX-Side tTA-GET
Interval Value

LP_BTA Vertical Scale (mV) 10 to 500
Vertical Position (div) -5 to 5
Vertical Offset (V) -1.3 to 1.3
Sample Rate (GS/s) • 6.25

• 12.5
• 25
• 50

Record Length 100000 to 50000000
Trigger Type • Transition

• Edge
• Width

Trigger Source • VA
• VB
• VC

Trigger Upper Level (V) -5 to 5
Trigger Lower Level (V) -6 to 1
Trigger Upper Limit (us)
Trigger Lower Limit (us)
Trigger Polarity • Positive

• Negative

Edge Trigger Level(V) 0 to 1
Trigger Time (ps) • 250

• 500

Trigger Transition • Less Than
• Greater Than

Trigger Slope • Positive
• Negative
• Either

Trigger If Violation • Occurs
• Logic
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TestName AcquireType ParameterName ParameterValue

1.4.1 HS-TX Differential Voltages
Unterminated (VOD(UT)-AB,
VOD(UT)-BC, VOD(UT)-CA)

1.4.2 HS-TX Differential
Voltage Mismatch Unterminated
(Delta_VOD(UT))

1.4.3 HS-TX Single-
Ended Output High
Voltages Unterminated
(VOHHS(UT)(VA),VOHHS(UT)
(VB),VOHHS(UT)(VC))

1.4.4 HS-TX Static Common-
Point Voltages Unterminated
(VCPTX(UT))

HS_Unterminated Vertical Scale (mV) 10 to 500
Vertical Position (div) -5 to 5
Vertical Offset (V) -1.3 to 1.3
Sample Rate (GS/s) • 6.25

• 12.5
• 25
• 50
• AUTO

Record Length 100000 to 10000000
Trigger Type • Transition

• Edge
• Width

Trigger Source • VA
• VB
• VC

Trigger Upper Level (V) -5 to 5
Trigger Lower Level (V) -6 to 1
Trigger Upper Limit (us)
Trigger Lower Limit (us)
Trigger Polarity • Positive

• Negative

Edge Trigger Level(V) 0 to 1
Trigger Time (ps) • 250

• 500

Trigger Transition • Less Than
• Greater Than

Trigger Slope • Positive
• Negative
• Either

Trigger If Violation • Occurs
• Logic
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TestName AcquireType ParameterName ParameterValue

1.5.1 t3-CALPREAMBLE
Duration

LPHS_Format1_CALPREAMBL
E

Vertical Scale (mV) 10 to 500
Vertical Position (div) -5 to 5
Vertical Offset (V) -1.3 to 1.3
Sample Rate (GS/s) • 6.25

• 12.5
• 25
• 50
• AUTO

Record Length 100000 to 10000000
Trigger Type • Transition

• Edge
• Width

Trigger Source • VA
• VB
• VC

Trigger Upper Level (V) -5 to 5
Trigger Lower Level (V) -6 to 1
Trigger Upper Limit (us)
Trigger Lower Limit (us)
Trigger Polarity • Positive

• Negative

Edge Trigger Level(V) 0 to 1
Trigger Time (ps) • 250

• 500

Trigger Transition • Less Than
• Greater Than

Trigger Slope • Positive
• Negative
• Either

Trigger If Violation • Occurs
• Logic

Table continued…
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TestName AcquireType ParameterName ParameterValue

1.5.2 t3-ASID Duration

1.5.3 t3-CALALTSEQ Duration

LPHS_Format2_CALPREAMBL
E

Vertical Scale (mV) 10 to 500
Vertical Position (div) -5 to 5
Vertical Offset (V) -1.3 to 1.3
Sample Rate (GS/s) • 6.25

• 12.5
• 25
• 50
• AUTO

Record Length 100000 to 10000000
Trigger Type • Transition

• Edge
• Width

Trigger Source • VA
• VB
• VC

Trigger Upper Level (V) -5 to 5
Trigger Lower Level (V) -6 to 1
Trigger Upper Limit (us)
Trigger Lower Limit (us)
Trigger Polarity • Positive

• Negative

Edge Trigger Level(V) 0 to 1
Trigger Time (ps) • 250

• 500

Trigger Transition • Less Than
• Greater Than

Trigger Slope • Positive
• Negative
• Either

Trigger If Violation • Occurs
• Logic

Table continued…
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TestName AcquireType ParameterName ParameterValue

1.5.4 Calibration Sequence t3-
SYNC Duration

LPHS_CALPREAMBLE Vertical Scale (mV) 10 to 500
Vertical Position (div) -5 to 5
Vertical Offset (V) -1.3 to 1.3
Sample Rate (GS/s) • 6.25

• 12.5
• 25
• 50
• AUTO

Record Length 100000 to 10000000
Trigger Type • Transition

• Edge
• Width

Trigger Source • VA
• VB
• VC

Trigger Upper Level (V) -5 to 5
Trigger Lower Level (V) -6 to 1
Trigger Upper Limit (us)
Trigger Lower Limit (us)
Trigger Polarity • Positive

• Negative

Edge Trigger Level(V) 0 to 1
Trigger Time (ps) • 250

• 500

Trigger Transition • Less Than
• Greater Than

Trigger Slope • Positive
• Negative
• Either

Trigger If Violation • Occurs
• Logic

Returns
<Nrf>
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Examples
TEKEXP:VALUE
ACQUIRE,”<TestName>",”<AcquireType>”,"<ParameterName>","<ParameterValue>" command sets
the value for the specified test and its acquire parameter.

TEKEXP:VALUE? ACQUIRE,”<TestName>",”<AcquireType>”,"<ParameterName>" command returns the
value for the specified test and its acquire parameter.

Set or query the analyze parameter values
This command sets or queries the analyze parameter values of the application.

Syntax
TEKEXP:VALUE ANALYZE,”<TestName>","<ParameterName>","<ParameterValue>" (Set)

TEKEXP:VALUE? ANALYZE,”<TestName>","<ParameterName>" (Query)

Command arguments

Table 20: For C-PHY 1.0

TestName ParameterName ParameterValue
1.1.1 Thevenin Output High Level Voltage (VOH) Supported Settings LP Signal Types
1.1.2 LP-TX Thevenin Output Low Level Voltage (VOL)
1.1.3 LP-TX 15%-85% Rise Time (tRLP)
1.1.4 LP-TX 15%-85% Fall Time (tFLP)
1.1.5 LP-TX Slew Rate vs. CLOAD (dV/dtSR)
1.1.6 LP-TX Pulse Width of Exclusive-OR Clock (tLP-
PULSE-TX)
1.1.7 LP-TX Period of Exclusive-OR Clock (tLP-PER-TX)
1.3.1 INIT: LP-TX Initialization Period (tINITMASTER)
1.3.2 ULPS Exit: Transmitted tWAKEUP Interval
1.3.3 BTA: TX-Side tTA-GO Interval Value
1.3.4 BTA: RX-Side tTA-SURE Interval Value
1.3.5 BTA: RX-Side tTA-GET Interval Value
1.2.1 tLPX Duration Supported Settings LP-HS Signal Types
1.2.2 t3-PREPARE Duration
1.2.3 t3-PREBEGIN Duration
1.2.16 t3-POST Duration
1.2.17 30%-85% Post-EoT Rise Time (tREOT)
1.2.18 tHS-EXIT Value
Table continued…
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TestName ParameterName ParameterValue
1.2.4 t3-PROGSEQ Duration Supported Settings HS Signal Types
1.2.5 t3-PREEND Duration
1.2.6 t3-SYNC Duration
1.2.7 HS-TX Differential Voltages (VOD_AB VOD_BC
VOD_CA)
1.2.8 HS-TX Differential Voltage Mismatch (Delta_VOD)
1.2.9 HS-TX Single-Ended Output High Voltages
(VOHHS(VA)VOHHS(VB)VOHHS(VC))
1.2.10 HS-TX Static Common-Point Voltages (VCPTX)
1.2.11 HS-TX Static Common-Point Voltage Mismatch
(Delta VCPTX(HS))
1.2.12 HS-TX Dynamic Common-Point Variations
Between 50-450MHz (Delta VCPTX(LF))
1.2.13 HS-TX Dynamic Common-Point Variations Above
450MHz (Delta VCPTX(HF))
1.2.14 HS-TX Rise Time (tR)
1.2.15 HS-TX Fall Time (tF)
1.2.20 HS Clock Delta UI (Delta_UI)
1.2.19 HS Clock Instantaneous UI (UIINST) UI INST MIN (ps) 1 to 12500000

Supported Settings HS Signal Types

Table 21: For C-PHY 1.1

TestName ParameterName ParameterValue
1.1.1 Thevenin Output High Level Voltage (VOH) Supported Settings LP Signal Types
1.1.2 LP-TX Thevenin Output Low Level Voltage (VOL)
1.1.3 LP-TX 15%-85% Rise Time (tRLP)
1.1.4 LP-TX 15%-85% Fall Time (tFLP)
1.1.5 LP-TX Slew Rate vs. CLOAD (dV/dtSR)
1.1.6 LP-TX Pulse Width of Exclusive-OR Clock (tLP-
PULSE-TX)
1.1.7 LP-TX Period of Exclusive-OR Clock (tLP-PER-TX)
1.3.1 INIT: LP-TX Initialization Period (tINITMASTER)
1.3.2 ULPS Exit: Transmitted tWAKEUP Interval
1.3.3 BTA: TX-Side tTA-GO Interval Value
1.3.4 BTA: RX-Side tTA-SURE Interval Value
1.3.5 BTA: RX-Side tTA-GET Interval Value
Table continued…
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TestName ParameterName ParameterValue
1.2.1 tLPX Duration Supported Settings LP-HS Signal Types
1.2.2 t3-PREPARE Duration
1.2.3 t3-PREBEGIN Duration
1.2.16 t3-POST Duration
1.2.17 30%-85% Post-EoT Rise Time (tREOT)
1.2.18 tHS-EXIT Value
1.2.4 t3-PROGSEQ Duration Supported Settings HS Signal Types
1.2.5 t3-PREEND Duration
1.2.6 t3-SYNC Duration
1.2.7 HS-TX Differential Voltages (VOD_AB VOD_BC
VOD_CA)
1.2.8 HS-TX Differential Voltage Mismatch (Delta_VOD)
1.2.9 HS-TX Single-Ended Output High Voltages
(VOHHS(VA)VOHHS(VB)VOHHS(VC))
1.2.10 HS-TX Static Common-Point Voltages (VCPTX)
1.2.11 HS-TX Static Common-Point Voltage Mismatch
(Delta VCPTX(HS))
1.2.12 HS-TX Dynamic Common-Point Variations
Between 50-450MHz (Delta VCPTX(LF))
1.2.13 HS-TX Dynamic Common-Point Variations Above
450MHz (Delta VCPTX(HF))
1.2.20 HS Clock Delta UI (Delta_UI)
1.4.1 HS-TX Differential Voltages Unterminated
(VOD(UT)-AB VOD(UT)-BC VOD(UT)-CA)
1.4.2 HS-TX Differential Voltage Mismatch Unterminated
(Delta_VOD(UT))
1.4.3 HS-TX Single-Ended Output High
Voltages Unterminated (VOHHS(UT)(VA)VOHHS(UT)
(VB)VOHHS(UT)(VC))
1.4.4 HS-TX Static Common-Point Voltages Unterminated
(VCPTX(UT))
1.2.19 HS Clock Instantaneous UI (UIINST) UI INST MIN (ps) 1 to 12500000

Supported Settings HS Signal Types
Table continued…
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TestName ParameterName ParameterValue
1.2.21 HS-TX Eye Diagram Clock Edge • RISE

• FALL
• BOTH

Clock Recovery Method • EXPEDGE
• EXPPLL

Signal Type • CLOCK
• DATA
• AUTO

Mask Hit Type • Auto
• Manual

Loop Bandwidth 1 to 10
Supported Settings HS Signal Types

Table 22: For C-PHY 2.0

TestName ParameterName ParameterValue
1.1.1 Thevenin Output High Level Voltage (VOH) Supported Settings LP Signal Types
1.1.2 LP-TX Thevenin Output Low Level Voltage (VOL)
1.1.3 LP-TX 15%-85% Rise Time (tRLP)
1.1.4 LP-TX 15%-85% Fall Time (tFLP)
1.1.5 LP-TX Slew Rate vs. CLOAD (dV/dtSR)
1.1.6 LP-TX Pulse Width of Exclusive-OR Clock (tLP-
PULSE-TX)
1.1.7 LP-TX Period of Exclusive-OR Clock (tLP-PER-TX)
1.3.1 INIT: LP-TX Initialization Period (tINITMASTER)
1.3.2 ULPS Exit: Transmitted tWAKEUP Interval
1.3.3 BTA: TX-Side tTA-GO Interval Value
1.3.4 BTA: RX-Side tTA-SURE Interval Value
1.3.5 BTA: RX-Side tTA-GET Interval Value
1.1.8 tLP-EXIT Value
Table continued…
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TestName ParameterName ParameterValue
1.2.1 tLPX Duration Supported Settings LP-HS Signal Types
1.2.2 t3-PREPARE Duration
1.2.3 t3-PREBEGIN Duration
1.2.16 t3-POST Duration
1.2.17 30%-85% Post-EoT Rise Time (tREOT)
1.2.18 tHS-EXIT Value
1.5.1 t3-CALPREAMBLE Duration
1.2.4 t3-PROGSEQ Duration Supported Settings HS Signal Types
1.2.5 t3-PREEND Duration
1.2.6 t3-SYNC Duration
1.2.7 HS-TX Differential Voltages (VOD_AB VOD_BC
VOD_CA)
1.2.8 HS-TX Differential Voltage Mismatch (Delta_VOD)
1.2.9 HS-TX Single-Ended Output High Voltages
(VOHHS(VA)VOHHS(VB)VOHHS(VC))
1.2.10 HS-TX Static Common-Point Voltages (VCPTX)
1.2.11 HS-TX Static Common-Point Voltage Mismatch
(Delta VCPTX(HS))
1.2.12 HS-TX Dynamic Common-Point Variations
Between 50-450MHz (Delta VCPTX(LF))
1.2.13 HS-TX Dynamic Common-Point Variations Above
450MHz (Delta VCPTX(HF))
1.2.19 HS Clock Instantaneous UI (UIINST)
1.2.22 HS-TX UI Jitter (UI_JitterPEAK_TX)
1.4.1 HS-TX Differential Voltages Unterminated
(VOD(UT)-AB VOD(UT)-BC VOD(UT)-CA)
1.4.2 HS-TX Differential Voltage Mismatch Unterminated
(Delta_VOD(UT))
1.4.3 HS-TX Single-Ended Output High
Voltages Unterminated (VOHHS(UT)(VA)VOHHS(UT)
(VB)VOHHS(UT)(VC))
1.4.4 HS-TX Static Common-Point Voltages Unterminated
(VCPTX(UT))
1.5.2 t3-ASID Duration
1.5.3 t3-CALALTSEQ Duration
1.5.4 Calibration Sequence t3-SYNC Duration
Table continued…
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TestName ParameterName ParameterValue
1.2.21 HS-TX Eye Diagram Clock Edge • RISE

• FALL
• BOTH

Clock Recovery Method • EXPEDGE
• EXPPLL

Signal Type • CLOCK
• DATA
• AUTO

Mask Hit Type • Auto
• Manual

Loop Bandwidth 1 to 10
Supported Settings HS Signal Types

Returns
<Nrf>

Examples
TEKEXP:VALUE ANALYZE,”<TestName>","<ParameterName>","<ParameterValue>" command set the
value for the specified test and its analyze parameter.

TEKEXP:VALUE? ANALYZE,”<TestName>","<ParameterName>" command returns the value for the specified test
and its analyze parameter.

Set or query the user defined acquisition values
This command sets or queries the user defined acquisition values.

Syntax
TEKEXP:USER_DEF_ACQ (Set)

TEKEXP:USER_DEF_ACQ? (Query)

Returns
{0 | 1} or {True | False}

1 or True indicates that the user defined acqusition is enabled.

0 or False indicates that the user defined acqusition is disabled.

Examples
TEKEXP:USER_DEF_ACQ? command returns the enable or disable status of user defined acquistion.

Query the available devices in the DUT panel of the application
This command queries the list of available devices on the DUT panel as comma separated values.
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Syntax
TEKEXP:LIST? DEVICE (Query)

Command arguments
Device Device Type and value Description
<Device> It is the name of the device on the DUT panel of the application.

Returns
<String>

Examples
TEKEXP:LIST? DEVICE command returns the list of available devices.

Query the available suites for the selected device
This command queries the list of available suites for the selected device as comma separated values.

Syntax
TEKEXP:LIST? SUITE (Query)

Returns
<String>

Examples
TEKEXP:LIST? SUITE command returns the list of available suites for the selected device.

Query the list of available tests of the application
This command queries the list of available tests of the application for the selected device as comma separated values.

Syntax
TEKEXP:LIST? TEST (Query)

Command arguments
NA

Returns
<String>

Examples
TEKEXP:LIST? TEST command returns the list of available tests for the selected device.

Query the available version names of the application
This command queries the list of available version names of the application for the selected device as comma separated values.

Syntax
TEKEXP:LIST? VERSION (Query)
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Returns
<String>

Examples
TEKEXP:LIST? VERSION command returns the list of version names for the selected device.

Query the list of available instruments based on the specified instrument type
This command queries the list of available instruments based on the specified instrument type.

Syntax
TEKEXP:LIST? INSTRUMENT,"<InstrumentType>" (Query)

Command argument
Argument Name Argument value
<InstrumentType> <String>

Returns
<String>

Examples
TEKEXP:LIST? INSTRUMENT,"Real Time Scope" command returns the list of available instruments based on the real
time scope type.

Set or query the IP address of the instrument based on the specified instrument
type
This command sets or queries the IP address of the instrument based on the specified instrument type.

Syntax
TEKEXP:INSTRUMENT? "<InstrumentType>" (Query)

TEKEXP:INSTRUMENT, "<InstrumentType>","<Value>" (Set)

Command argument
Argument Name Argument Type
<InstrumentType> <String>
<Value> <String>

TCPIP::XXX.XX.XXX.XXX::INSTR

Returns
<String>

Examples
TEKEXP:INSTRUMENT? "<InstrumentType>" command returns the IP address of the oscilloscope.
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TEKEXP:INSTRUMENT, "<InstrumentType>","<value>" command sets the oscilloscope to the specified IP address.

Query the information of the generated report file
This command queries the information of the generated report file in the format "<FileSize>","<FileName>".

Pre‐requisite
A session should be run earlier and the report should be generated to get the information of the report.

Syntax
TEKEXP:INFO? REPORT (Query)

Returns
<FileSize>:: <String>

<FileName>:: <String>

Examples
TEKEXP:INFO? REPORT command returns the information of the generated report in the format ("1215”,"DUT001.mht”).

Query the information of the generated waveform files
This command queries the information of the generated waveform files in the format.

<File1Size,"File1Name”>.

If there are more than one waveform, the waveform file names are displayed with the comma separated values in the format

<File1Size,"File1Name">,<File2Size,"File2Name">.

Syntax
TEKEXP:INFO? WFM (Query)

Returns
<FileSize>:: <String>

<FileName>:: <String>

Examples
TEKEXP:INFO? WFM command returns the information of the generated waveform in the format (20000858,"X:\<Application
Name>\Untitled Session\DUT001\20200916_041609\Iter1_Short Record‐length for SCOPE Period_NoSSC_DIFF.wfm”).

Query the information of the generated image files
This command queries the information of the generated image files in the format.

<File1Size,"File1Name”>.

If there are more than one image, the image file names are displayed with the comma separated values in the format

<File1Size,"File1Name">,<File2Size,"File2Name">.

Syntax
TEKEXP:INFO? IMAGE (Query)
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Returns
<FileSize>:: <String>

<FileName>:: <String>

Examples
TEKEXP:INFO? IMAGE command returns the information of the generated image
in the format (109058, "X:\<Application Name>\Untitled Session\DUT001\20200916_041609\Iter1_Short
Record‐length for SCOPE Period_NoSSC_DIFF.png";22794,"X:\<Application Name>\UntitledSession\DUT001\20
200916_041609\ScopePeriodPlot_Iteration1WithCursor.png").

Query the active TekExpress application name
This command queries the active TekExpress application name running on the oscilloscope.

Syntax
TEKEXP:*IDN? (Query)

Returns
<String>

Examples
TEKEXP:*IDN? command returns the active TekExpress application name running on the oscilloscope.

Sets or query the acquire mode status
This command sets or queries the acquire mode status.

Syntax
TEKEXP:ACQUIRE_MODE <Mode> (Set)

TEKEXP:ACQUIRE_MODE? (Query)

Command arguments
Argument Name Argument value
<Mode> • LIVE

• PRE‐RECORDED

Returns
LIVE | PRE‐RECORDED

Examples
TEKEXP:ACQUIRE_MODE LIVE command sets the acquire mode to the Live mode.

TEKEXP:ACQUIRE_MODE? command returns the current acquire mode.

Set or query the execution mode status
This command sets or queries the execution mode status.
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Syntax
TEKEXP:MODE <Mode> (Set)

TEKEXP:MODE? (Query)

Command arguments
Argument Name Argument value
<Mode> • COMPLIANCE

• USER‐DEFINED

Returns
COMPLIANCE | USER‐DEFINED

Examples
TEKEXP:MODE COMPLIANCE command sets the execution mode to the compliance mode.

TEKEXP:MODE? command returns the current execution mode.

Generate the report for the current session
This command generates the report for the current session.

Syntax
TEKEXP:REPORT GENERATE(Set)

Arguments
N/A

Examples
TEKEXP:REPORT GENERATE command generates the report for the current session.

Query the value of specified report header field in the report
This command queries the value of specified report header field in the report.

Syntax
TEKEXP:REPORT? ”<Device Field>” (Query)
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Command arguments
Argument Name Argument Type
<Device Field>

Device field is the header name of each field in the setup
information section of the report.

<String>

Returns
<String>

Examples
TEKEXP:REPORT? "DUT ID" command returns the value of DUT ID field in the report.

Query the value of specified result detail available in report summary/details
table
This command queries the value of specified result detail available in report summary/details table.

Syntax
TEKEXP:RESULT? "<TestName>" (Query)

TEKEXP:RESULT? "<TestName>","<ColumnName>" (Query)

TEKEXP:RESULT? "<TestName>","<ColumnName>",<RowNumber> (Query)

Command arguments
Argument Name Argument Type
<TestName>

It is the test name of which the details are required in the report.

<String>

<ColumnName>

It is the column header name of which the details are required in the
report.

<String>

<RowNumber>

It is the row number of which the details are required in the report.

<String>

Returns
<String>

Examples
TEKEXP:RESULT? "<TestName>" will return the pass fail status of test.
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TEKEXP:RESULT? "<TestName>","<ColumnName>" will return all the row values of specific column for the test with
comma separated values.

TEKEXP:RESULT? "<TestName>","<ColumnName>",<RowNumber> will return the column value of specified row
number.

Restore the setup to default settings
This command restores the setup to default settings.

Syntax
TEKEXP:SETUP Default (Set)

Arguments
N/A

Examples
TEKEXP:SETUP Default command restores the setup to default settings.

Save the settings to a specified session
This command saves the settings to a specified session.

Syntax
TEKEXP:SETUP Save,"<SessionName>"
Command arguments
Argument Name Argument value
<SessionName> <String>

Examples
TEKEXP:SETUP Save,"<SessionName>" command saves the settings to a specified session.

Open the setup from a specified session
This command opens the setup from a specified session.

Syntax
TEKEXP:SETUP Open,"<SessionName>" (Set)

Command arguments
Argument Name Argument value
<SessionName> <String>

Examples
TEKEXP:SETUP Open,"<SessionName>" command opens the setup from a specified session.
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Query the current setup file name
This command queries the current setup file name.

Syntax
TEKEXP:SETUP? CURRENT (Query)

Returns
<String>

Examples
TEKEXP:SETUP? CURRENT command returns the current setup file name.

Run/stop/pause/resume the selected measurements execution in the application
This command run/stop/pause/resume the selected measurements execution in the application.

Syntax
TEKEXP:STATE <operation mode> (Set)

Command arguments
Argument Name Argument value
<operation mode> • RUN

• STOP
• PAUSE
• RESUME

Returns
RUN | STOP | PAUSE | RESUME

Examples
TEKEXP:STATE RUN command runs the execution for the selected measurements.

Query the current measurement execution status
This command queries the current measurement execution status.

Syntax
TEKEXP:STATE? (Query)

Returns
RUNNING | PAUSED | WAIT | ERROR | READY

Examples
TEKEXP:STATE? command returns the current measurement execution status.
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Query whether the current setup is saved or not saved
This command queries whether the current setup is saved or not saved.

Syntax
TEKEXP:STATE? SETUP (Query)

Returns
Saved or Not‐Saved

Examples
TEKEXP:STATE? SETUP command returns whether the current setup is saved or not saved.

Query the status of the previous command execution
This command queries whether the previous command execution is completed successfully.

Syntax
TEKEXP:*OPC? (Query)

Returns
{0 | 1} or {True | False}

1 or True indicates that command execution is successful.

0 or False indicates that command execution is failed.

Examples
TEKEXP:*OPC? command returns whether the previous command operation is completed successfully.

Query the last error occurred
This command queries the last error occurred.

Syntax
TEKEXP:LASTERROR? (Query)

Returns
<String>

Examples
TEKEXP:LASTERROR? command returns the last error occurred.

Set or query the popup details
This command sets or queries the popup details.

Syntax
TEKEXP:POPUP? (Query)

TEKEXP:POPUP "<PopupResponse>" (Set)
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Command arguments
Argument Name Argument value
<PopupResponse> • Yes

• No

Returns
The pop‐up details return in the following format:

"<Tittle>","<message>","<response1>,<response2>".

Where,

<Tittle> :: <String>

<message> :: <String>

<response1>,<response2> :: <String>

Examples
TEKEXP:POPUP? command returns the popup details in following format ": "Do you really want to exit TekExpress?";Responses: "Yes,
No".

TEKEXP:POPUP "Yes" command sets the popup response to Yes.

Query the enable or disable status of Continuous run function.
This command queries the enable or disable status of Continuous run function.

Syntax
TEKEXP:VALUE? GENERAL,"Enable Continuous Run" (Query)

Returns
{True | False} or {0 | 1}

Where,

1 or True indicates that the continuous run function is enabled.

0 or False indicates that the continuous run function is disabled.

Examples
TEKEXP:VALUE? GENERAL,"Enable Continuous Run" command returns the enable or disable status of continuous run
function.

Set or query the enable/disable status of Continuous Run function
This command sets or queries the enable/disable status of Continuous Run function.

Syntax
TEKEXP:VALUE ContinuousRun,"<Value>" (Set)

TEKEXP:VALUE? ContinuousRun (Query)
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Arguments
Argument Name Argument value
<Value> {True | False} or {1 | 0}

It represents enabled or disabled.

Where,

• True or 1 - enabled
• False or 0 - disabled

Returns
{True | False} or {0 | 1}

Examples
TEKEXP:VALUE? ContinuousRun command returns the enable or disable status of Continuous run function.

TEKEXP:VALUE ContinuousRun,"<Value>" command enable or disable the Continuous run function.

Set or query the enable/disable status of Verbose function
This command sets or queries the enable/disable status of Verbose function.

Syntax
TEKEXP:VALUE VERBOSE,"<Value>" (Set)

TEKEXP:VALUE? VERBOSE (Query)

Arguments
Argument Name Argument value
<Value> {True | False} or {1 | 0}

It represents enabled or disabled.

Where,

• True or 1 - enabled
• False or 0 - disabled

Returns
{True | False} or {0 | 1}

Examples
TEKEXP:VALUE VERBOSE,"<Value>" command enable or disable the Verbose function.

TEKEXP:VALUE? VERBOSE command returns the enable or disable status of Verbose function.

Set or query the continuous run duration time value
This command sets or queries the continuous run duration time value.
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Syntax
TEKEXP:VALUE? ContinuousRun_Duration (Query)

TEKEXP:VALUE ContinuousRun_Duration,"<Value>" (Set)

Arguments
Argument Name Argument value
<Value> Infinite | hh:mm

Infinite sets the radio on button to infinite.

hh:mm sets the continuous run duration to the specified time in
hours and minutes. The minimum time duration you can set is
00:30.

Returns
Infinite | hh:mm

Examples
TEKEXP:VALUE? ContinuousRun_Duration command returns the continuous run duration time value.

TEKEXP:VALUE ContinuousRun_Duration,"<Value>" command sets the continuous run duration time value.

Set or query the session create option in the continuous run function
This command sets or queries the option for session creation in the continuous run function.

Syntax
TEKEXP:VALUE? ContinuousRun_RunSessionOptions (Query)

TEKEXP:VALUE ContinuousRun_RunSessionOptions,"Value" (Set)

Arguments
Argument Name Argument value
<Value> NewSession | SameSession_ClearResults

NewSession - creates new session for each run.

SameSession_ClearResults - Clears the test results of the current
session and starts the test execution. The session results will be
added in the same session, by erasing the previous run results.

Returns
NewSession | SameSession_ClearResults

Examples
TEKEXP:VALUE? ContinuousRun_RunSessionOptions command returns the option for session creation in the
continuous run function.

TEKEXP:VALUE ContinuousRun_RunSessionOptions,"Value" command sets the option for session creation in the
continuous run function.
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Set or query the View report after generating option status
This command sets or queries the enable/disable status of the View report after generating function.

Syntax
TEKEXP:VALUE? GENERAL,"View Report After Generating" (Query)

TEKEXP:VALUE GENERAL,"View Report After Generating",<value> (Set)

Arguments
Argument Name Argument value
<Value> {True | False} or {1 | 0}

It represents enabled or disabled.

Where,

• True or 1 - enabled
• False or 0 - disabled

Returns
{True | False} or {0 | 1}

Examples
TEKEXP:VALUE? GENERAL,"View Report After Generating" command returns the enable or disable status of
view report after generating option.

TEKEXP:VALUE GENERAL,"View Report After Generating",<value> command enable or disable the view
report after generating option.

Sets or query the limit values in the limits editor window
This command sets or queries the limit values in the limits editor window.

Syntax
TEKEXP:VALUE LIMIT,<TestName>,<LimitHeader>,<Value1>,<CompareString>,<Value2>(Set)

TEKEXP:VALUE? LIMIT,<TestName>,<LimitHeader> (Query)

Returns
<String> or <NRf>

Examples
TEKEXP:VALUE LIMIT,<TestName>,<LimitHeader>,<Value1>,<CompareString>,<Value2> command
sets the limits value for the specified testname and limit header.

TEKEXP:VALUE? LIMIT,<TestName>,<LimitHeader> command returns the limits value for the specified testname and
limit header.
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Set or query the waveform file recalled for the specified test name and acquire
type
This command set or queries the waveform file recalled for the specified test name and acquire type.

If there are more than one waveform, the waveform file names are displayed with the symbol "$" separated values in the format

<WaveformFileName1$ WaveformFileName2>.

Syntax
TEKEXP:VALUE WFMFILE,<TestName>,<AcquireType>,<WaveformFileName> (Set)

TEKEXP:VALUE? WFMFILE,<TestName>,<AquireType> (Query)

Returns
<String>

Examples
TEKEXP:VALUE WFMFILE,<TestName>,<AquireType>,<WaveformFileName> command recalls the sepcified
waveform file for the specified testname and acquire type.

TEKEXP:VALUE? WFMFILE,<TestName>,<AquireType> command returns the waveform file name recalled for the
specified testname and acquire type.

Set the default session
Sets the application configurations to default value.

Syntax
TEKEXP:SESSION DEFAULT (set)

Examples
TEKEXP:SESSION DEFAULT, sets the application configurations to default value.

Save the run/config sessions
Enter the name to save the run/config session.

Syntax
TEKEXP:SESSION SAVE,“Session Name” (set)

Command arguments
Argument Name Argument value
<Session Name> <String>

Examples
TEKEXP:SESSION SAVE,“Session Name” saves the session.
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Load the run/config session
Load the selected config/run session.

Syntax
TEKEXP:SESSION LOAD, “Session Name” (set)

Command arguments
Argument Name Argument value
<Session Name> <String>

Examples
TEKEXP:SESSION LOAD, “Session Name”, load the selected config/run session.

Delete the run/config session
Deletes the selected config/run session.

Syntax
TEKEXP:SESSION DELETE, "Session1, Session2" (set)

Command arguments
Argument Name Argument value
<Session Name> <String>

Examples
TEKEXP:SESSION DELETE, "Session1, Session2", deletes the selected config/run session.

Run the run/config saved session
Run the selected config/run session.

Syntax
TEKEXP:SESSION RUN, “Session Name’s separated by comma” (set)

Command arguments
Argument Name Argument value
<Session Name> <String>
Session Name’s separated by comma (to run the multiple run
sessions)

<String>

Examples
TEKEXP:SESSION RUN, “Session Name’s separated by comma”, runs the selected config/run session.
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Query the available list in the run/config session
Returns the list of available config/run session.

Syntax
TEKEXP:SESSION? LIST
Returns
Returns the list of available config/run session.

Examples
TEKEXP:SESSION? LIST, returns the list of available config/run session.

Query the current run/config session
Returns the selected config/run session.

Syntax
TEKEXP:SESSION? CURRENT
Returns
Returns the selected config/run session.

Examples
TEKEXP:SESSION? CURRENT, returns the selected config/run session.

Override the run/config session
Overrides the selected config/run session.

Syntax
TEKEXP:SESSION SAVE,"SessionName", "True" (set)

Command arguments
Argument Name Argument Type Argument Value
<Session Name> <String> {True | False} or {1 | 0}

It represents enabled or disabled.

Where,

• True or 1 - enabled
• False or 0 - disabled

Returns
{True | False} or {0 | 1}

Examples
TEKEXP:SESSION SAVE,"SessionName", "True", overrides the selected config/run session.
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Example
import socket

import time

#Create Socket

skt= socket.socket(socket.AF_INET,socket.SOCK_STREAM)

scopeIpAddress = "localhost"

tekexpressPortNo = 5000

#Connect to TekExpress applicaiton with scope IP address and port no

skt.connect((scopeIpAddress,tekexpressPortNo))

print ""

#Measurement for execution

measurement = "1.2.13 HS-TX Dynamic Common-Point Variations Above 450MHz (Delta VCPTX(HF))"

#Setting the Mode to LIVE

skt.sendall("TEKEXP:ACQUIRE_MODE LIVE\n")

#setting the device

skt.sendall("TEKEXP:SELECT DEVICE,\"TX-Device\"\n")

time.sleep (2)

skt.sendall("TEKEXP:SELECT? DEVICE\n")

time.sleep (2)

status=str(skt.recv(1024))

print "The selected device is : "+status

# Select the Suite

skt.sendall("TEKEXP:SELECT SUITE,\"C-PHY 2.0\"\n")

skt.sendall("TEKEXP:SELECT? SUITE\n")

time.sleep (5)

status=str(skt.recv(1024))

print "The selected Suite is : "+status

#GENERAL Parameters SCPI Commands

print "Started setting the GENERAL parameters"

#Set DUT ID

dutid = "DemoDUTID"

skt.sendall("TEKEXP:VALUE DUTID,"+dutid+"\n")

time.sleep(2)

skt.sendall("TEKEXP:VALUE? DUTID\n")

time.sleep (5)
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status=str(skt.recv(1024))

print "After setting the DUT Id :"+status

skt.sendall("TEKEXP:SELECT TEST,ALL,FALSE\n")

print "Deselect all tests. "

time.sleep (5)

#Select Measurment

skt.sendall("TEKEXP:SELECT TEST,\"1.2.13 HS-TX Dynamic Common-Point Variations Above 450MHz (Delta VCPTX(HF))\"\n")

print "Selected Test : 1.2.13 HS-TX Dynamic Common-Point Variations Above 450MHz (Delta VCPTX(HF)) "

skt.sendall("TEKEXP:STATE RUN\n")

print "Clicked start button."

time.sleep (5)

skt.sendall("TEKEXP:POPUP \"OK\"\n")

time.sleep(10)

skt.sendall("TEKEXP:STATE?\n")

time.sleep (5)

response = str(skt.recv(1024))

response= response.strip()

print "Current Status after clicking on Start: "+response

while (response == "RUNNING" or response == "ERROR" or response=="WAIT"):

print "Running...Inside While"

time.sleep(15)

skt.sendall("TEKEXP:STATE?\n")

time.sleep(3)

response = str(skt.recv(1024))

response = response.strip()

if response == "ERROR" or response=="WAIT":

skt.sendall("TEKEXP:POPUP?\n")

response = str(skt.recv(1024))

print response

skt.sendall("TEKEXP:POPUP \"Continue\"\n")

print "Measurement execution completed."

print "Getting the info of Report file..."

skt.sendall("TEKEXP:INFO? REPORT\n")

response = str(skt.recv(1024))

print "ReportFile Info: "+response

fileInfo= response.split(',')
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fileLength = long(fileInfo[0])

destinationPath = "C:\\Python27\\"

print "Exporting report file to client location "+destinationPath+" ..."

skt.sendall("TEKEXP:EXPORT REPORT\n")

#response = str(skt.recv(1024))

while(len(response) < fileLength):

received = skt.recv(fileLength)

response = response + received

fileName = fileInfo[1].strip()

fileName = fileName.strip('\"')

f= open(destinationPath+fileName,'wb')

f.write(response)

f.close()

print "Export completed for "+fileName

print "Querying the result of \"1.2.13 HS-TX Dynamic Common-Point Variations Above 450MHz (Delta VCPTX(HF))\"..."

skt.sendall("TEKEXP:RESULT? \"1.2.13 HS-TX Dynamic Common-Point Variations Above 450MHz (Delta VCPTX(HF))\"\n")

response = str(skt.recv(1024))

print "The result of \"1.2.13 HS-TX Dynamic Common-Point Variations Above 450MHz (Delta VCPTX(HF))\" is "+response

skt.close()
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References

Application directories
You can find the application files at C:\Program Files\Tektronix\<Application Name>. The application directory and associated files are
organized as follows:

The following table lists the default directory names and their usage:

Table 23: Application directories and usage

Directory names Usage

Bin Contains application libraries

Compliance Suites Contains test suite specific files

Examples Contains various support files

ICP Contains instrument and application specific interface libraries

Images Contains images of the application

Lib Contains utility files specific to the application

Licenses Contains all the license files

Report Generator Contains style sheets for report generation

Tools Contains instrument and application specific files
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File name extensions
The TekExpress <Application Name> software uses the following file name extensions:

Table 24: File name extension

File name extension Description
*.TekX Application session files (the extensions may not be displayed)
*.py Python sequence file.
*.xml Test-specific configuration information (encrypted) files.

Application log files

*.csv Test result reports

Plot data

*.mht Test result reports (default)

Test reports can also be saved in HTML format

*.pdf Test result reports

Application help document

*.xslt Style sheet used to generate reports
*.png Captured images

View test-related files
Files related to tests are stored in My Documents\<Application Name>\Untitled session folder. Each test setup in this folder has both a test
setup file and a test setup folder, both with the test setup name. The test setup file is preceded by the TekExpress icon.

Inside the test setup folder is another folder named for the DUT ID used in the test sessions. The default is DUT001.

Inside the DUT001 folder are the session folders and files. Each session also has a folder and file pair, both named for the test session
using the naming convention (date)_(time). Each session file is stored outside its matching session folder:

Each session folder contains image files of any plots generated from running the test session. If you selected to save all waveforms or ran
tests using prerecorded waveform files, these are included here.
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The first time you run a new, unsaved session, the session files are stored in the Untitled Session folder located at X: \<Application Name>.
When you name and save the session, the files are placed in a folder with the name that you specify. A copy of the test files stay in the
Untitled Session folder until you run a new test or until you close the application.

Probe and termination voltage
Test Type CTS 2.0

Test ID
Test Name

Connection type

Termination
Voltage

Probe Setup

LP Tests 1.1.1 LP-TX Thevenin Output High Level Voltage (VOH) No Differential Probe with
RTB\Capacitive load1.1.2 LP-TX Thevenin Output Low Level Voltage (VOL)

ESCAPEMODE
LP-TX Thevenin Output Low Level Voltage (VOL)

1.1.3 LP-TX 15%-85% Rise Time (TRLP) ESCAPEMODE
1.1.4 LP-TX 15%-85% Fall Time (TFLP) ESCAPEMODE

LP-TX 15%-85% Fall Time (TFLP)
1.1.5 LP-TX Slew Rate vs. CLOAD (RiseEdgeMax)

LP-TX Slew Rate vs. CLOAD (RiseEdgeMin)
LP-TX Slew Rate vs. CLOAD (RiseEdgeMargin)
LP-TX Slew Rate vs. CLOAD (FallEdgeMax)
LP-TX Slew Rate vs. CLOAD (FallEdgeMin)

1.1.6 LP-TX Pulse Width of Exclusive-OR Clock (TLP-
PULSE-TX)
LP-TX Pulse Width of Exclusive-OR Clock (TLP-
PULSE-TX) [Initial]

1.1.7 LP-TX Period of Exclusive-OR Clock (TLP-PER-TX)
[Rising-to-Rising]
LP-TX Period of Exclusive-OR Clock (TLP-PER-TX)
[Falling-to-Falling]

1.1.8 tLP-EXIT Value
HS Timing Tests 1.2.1 TLPX Duration No Differential Probe with RTB

1.2.2 T3-PREPARE Duration
1.2.3 T3-PREBEGIN Duration
1.2.4 T3-PROGSEQ Duration
1.2.5 T3-PREEND Duration
1.2.6 T3-SYNC Duration

Table continued…
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Test Type CTS 2.0
Test ID

Test Name

Connection type

Termination
Voltage

Probe Setup

HS Electrical
Tests

1.2.7 HS-TX Differential Voltages (VOD-AB-Strong1) [Max] Yes Direct DSO Connection with
SMAHS-TX Differential Voltages (VOD-AB-Weak1) [Min]

HS-TX Differential Voltages (VOD-AB-Weak0) [Max]
HS-TX Differential Voltages (VOD-AB-Strong0) [Min]
HS-TX Differential Voltages (VOD-BC-Strong1) [Max]
HS-TX Differential Voltages (VOD-BC-Weak1) [Min]
HS-TX Differential Voltages (VOD-BC-Weak0) [Max]
HS-TX Differential Voltages (VOD-BC-Strong0) [Min]
HS-TX Differential Voltages (VOD-CA-Strong1) [Max]
HS-TX Differential Voltages (VOD-CA-Weak1) [Min]
HS-TX Differential Voltages (VOD-CA-Weak0) [Max]
HS-TX Differential Voltages (VOD-CA-Strong0) [Min]

1.2.8 HS-TX Differential Voltage Mismatch (ΔVOD)
1.2.9 HS-TX Single-Ended Output High Voltages

(VOHHS(VA))
HS-TX Single-Ended Output High Voltages
(VOHHS(VB))
HS-TX Single-Ended Output High Voltages
(VOHHS(VC))

1.2.10 HS-TX Static Common-Point Voltages
(VCPTX_HS_+X)
HS-TX Static Common-Point Voltages
(VCPTX_HS_X)
HS-TX Static Common-Point Voltages
(VCPTX_HS_+Y)
HS-TX Static Common-Point Voltages
(VCPTX_HS_Y)
HS-TX Static Common-Point Voltages
(VCPTX_HS_+Z)
HS-TX Static Common-Point Voltages
(VCPTX_HS_Z)

1.2.11 HS-TX Static Common-Point Voltage Mismatch
(ΔVCPTX(HS))

1.2.12 HS-TX Dynamic Common-Point Variations Between
50-450 MHz (ΔVCPTX(LF))

1.2.13 HS-TX Dynamic Common-Point Variations Above 450
MHz (ΔVCPTX(HF))

1.2.14 HS-TX Rise Time (tR) [1.5Gbps and below] Yes Direct DSO Connection with
SMAHS-TX Rise Time (tR) [above 1.5Gbps]

1.2.15 HS-TX Fall Time (tF) [1.5Gbps and below]
HS-TX Fall Time (tF) [above 1.5Gbps]

Table continued…
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Test Type CTS 2.0
Test ID

Test Name

Connection type

Termination
Voltage

Probe Setup

HS Timing Tests 1.2.16 T3-POST Duration No Differential Probe with RTB
1.2.17 30%-85% Post-EoT Rise Time (TREOT)
1.2.18 THS-EXIT Value

HS Electrical
Tests

1.2.19 HS Clock Instantaneous UI (UIINST_Max) Yes Direct DSO Connection with
SMA1.2.20 HS Clock Delta UI (ΔUI) [1Gbps and below]

HS Clock Delta UI (ΔUI) [above 1Gbps]
1.2.21 HS-TX Eye diagram Yes Direct DSO Connection with

SMA1.2.22 HS-TX UI Jitter (UI_JitterPEAK_TX)
LP Timing Tests
manual

1.3.1 INIT: LP-TX Initialization Period (tINIT,MASTER) No Differential Probe with
Capacitive load\RTB1.3.2 ULPS Exit: Transmitted tWAKEUP Interval

BIDIR Timing
Tests

1.3.3 BTA: TX-Side tTA-GO Interval Value No Differential Probe with
Master\Slave Configuration1.3.4 BTA: RX-Side tTA-SURE Interval Value

1.3.5 BTA: RX-Side tTA-GET Interval Value
DC Level Tests 1.4.1 [VOD(UT)] No Differential Probe with RTB

and dip switch settings in
unterminated mode

1.4.2 [Delta VOD(UT)]
1.4.3 VOOHS(UT)]
1.4.4 VCPTX(UT)

CAL PRE Timing
Tests

1.5.1 t3-CALPREAMBLE Duration (Informative) No Differential Probe with RTB
1.5.2 t3-ASID Duration (Informative)
1.5.3 t3-CALALTSEQ Duration (Informative)
1.5.4 Calibration Sequence t3-SYNC Duration (Informative)

See also
Instrument connection setup

Default values

Parameter Name HS LP
SR AUTO AUTO
RL 2M Group 2, 4 and 5 1M Group 1 and Group 3 all
Width trigger 0.125ns-12.5ns @ 0.2V 10ns-100us @ 0.55V
Transition trigger 0.1V-0.3V, default delta, LT 0.25V-0.8V, default delta, GT
Edge trigger 0.2 0.55
Vertical Scale 200mV
Vertical Position -2.6 div
Vertical Offset 0V
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Parameter Name and Value for Width Trigger Range
Parameter Name Parameter Value
Width Trigger Range 0 to 1000 μs (Lower and Upper Limits)

DUT Panel
Parameter Description
Version C-PHY 2.0
Default Symbol Rate 8 Gsps
Termination Voltage 0.2425V
T3 Post Duration (UI) 7
PROGSEQ 00111222333444
Signal Type LP-HS
LVLP Unchecked
LVHS Unchecked
ALP Unchecked
User Defined Acquisition Unchecked

Test Selection Panel
Setting Description
Tests Except Group 5 all other tests will be enabled for Signal Type as

LP-HS

Acquisition Panel
Setting Description
Lane Lane0
VA CH1
VB CH2
VC CH3
Show Acquire Parameters Unchecked

Configuration Panel
Global Settings Description
Compliance Mode Selected
User Defined Mode Selected
Auto set for Vertical Settings Enabled
Insertion Loss Unchecked and default is Standard
CTLE Unchecked
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